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FOR PRODUCTS PURCHASED IN UNITED STATES
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may use either the current or prior version of the Software, but never
both versions at the same time. This Agreement supersedes any prior
version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have or intend to have on your network. For
computers or workstations attached to a public messaging system, the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this Agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software. If you have licensed this Software under an
education or charitable institution pricing program, you may not
create an extra copy of the Software under this provision for use on a
home or portable computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If for any reason you are
dissatisfied with the Software, return the product package, with

proof of purchase, to your reseller within 90 days for a full

refund. If any materials or media in this package are defective,

return them to Novell within 90 days of the date of purchase, and
they will be replaced at no charge.

These warranties are in lieu of any other warranties, express or

implied, including the implied warranties of merchantability and
fitness for a particular purpose. In no event will Novell be liable

to you for damages, including any lost profits, lost savings, or

other incidental or consequential damages arising out of your use

of or inability to use the Software, even if Novell or an authorized
Novell representative has been advised of the possibility of such

damages.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions that may supersede this limitation of liability
and may not apply to you if prohibited by the laws of your
jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell's current applications programs support
policies, Novell will attempt to answer your technical support request
concerning the Software; however, this service is offered on a
reasonable efforts basis only, and Novell may not be able to resolve
every support request. Novell supports the Software only if it is used
under conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions. This Agreement shall be governed by
the laws of the State of Utah.

U.S. GOVERNMENT RESTRICTED RIGHTS.
The Software and any accompanying materials are provided with
Restricted Rights. Use, duplication, or disclosure by the Government
is subject to restrictions as set forth in subparagraph (c) (1) (ii) of The
Rights in Technical Data and Computer Software clause at DFARS
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial
Computer Software-Restricted Rights at 48 CFR 52.227-19, as
applicable. Contractor/manufacturer is Novell, Inc., at the address
below.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement,
please refer to the Questions and Answers which follows this
Agreement. If you have further questions about this Agreement or
about special programs for educational or charitable organizations,
please write to WordPerfect, Novell Applications Group, Attn. Sales
Center, 1555 N. Technology Way, Orem, Utah 84057-2399, or call
(801) 225-5000.



FOR PRODUCTS PURCHASED IN ALL OTHER COUNTRIES
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on
which you use the Software.

If you have licensed this Software under an education or charitable
institution pricing program, you may not create an extra copy of the
Software under this provision for use on a home or portable
computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. If any materials or media in this
package are defective, return them within 90 days of the date of

purchase, and they will be replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER

WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND

FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT

WILL NOVELL BE LIABLE TO YOU FOR DAMAGES,

INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES

ARISING OUT OF YOUR USE OF OR INABILITY TO USE

THE SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED

NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied

warranties or limiting liability for incidental or consequential

damages, and some jurisdictions have special statutory consumer

protection provisions which may supersede this limitation. As a
result, this limitation of liability may not apply to you if

prohibited by the laws of your jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell's current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and shall not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organizations, please
contact your local WordPerfect office or authorized distributor or
write WordPerfect, Applications Division of Novell, Inc. Attn. Sales
Center, 1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.,
or call 801/222-4200.



FOR PRODUCTS PURCHASED IN AUSTRALIA-NEW ZEALAND
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorised to use a copy of the Software on a home or
portable computer, provided the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on which
you use the Software.

If you have purchased this Software under an educational institution
or charitable institution pricing programme, you may not create an
extra copy of the Software under this provision for use on a home or
portable computer.

LIMITED WARRANTY/LIMITATIONS OF LIABILITY
A. This Part A is subject to provisions of Part B which follows
below. This Software is licensed AS IS. If any materials or media in
this package are defective, please return them within 90 days of the
date of purchase, and they will be replaced free of charge.

These warranties are in lieu of any other warranties, express or
implied, including the implied warranties of merchantability and
fitness for a particular purpose. In no event will Novell be liable to
you for damages, including any loss of profits, lost savings, or other
incidental or consequential damages arising out of your use of or
inability to use the software, even if Novell or an authorised Novell
representative has been advised of the possibility of such damages.

B. Trade Practices Act. Where any legislation such as the Trade
Practices Act 1974, implies into this Agreement any condition or
warranty and that legislation avoids or prohibits provisions in a
contract excluding the application of the condition or warranty, the
liability of Novell for any breach of the condition or warranty is
limited at the option of Novell to any one or more of the following:
a) if the breach relates to goods, replacing the goods or the payment
of the cost of acquiring equivalent goods or repairing the goods or
payment of the cost of repairing the goods; b) if the breach relates to
services, the supplying of the services again or the payment of the
cost of having the services supplied again.

Nothing in this Agreement is intended to restrict or exclude any
liability of Novell under Part VA of the Trade Practices Act 1974.

CUSTOMER SUPPORT
Subject always to Novell's current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and shall not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programmes for educational or charitable organisations,
please contact your local WordPerfect office or authorised distributor
or write WordPerfect, Applications Division of Novell, Inc. Attn.
Sales Center, 1555 N. Technology Way, Orem, Utah 84057-2399
U.S.A., or call 801/222-4200.



FOR PRODUCTS PURCHASED IN UNITED KINGDOM
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc. (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

SPECIAL PROVISIONS
Novell grants you a special licence to place an extra copy of the
Software on a home or laptop computer, as long as the extra copy is
never loaded at the same time the Software is Loaded on the primary
computer on which you use the Software.

Special licensing provisions may apply for a qualified educational of
charitable institution.

LIMITED WARRANTY/LIMITATION OF LIABILITY
If you enter into this Licence agreement as part of a consumer

transaction: if any materials of media in this package are

defective, return them within 90 days of the original date of
purchase and Novell will replace them at no charge. THE

FOREGOING DOES NOT AND WILL NOT AFFECT YOUR

STATUTORY RIGHTS AS A CONSUMER.

If you do not enter into this Licence Agreement as part of a

consumer transaction: THIS SOFTWARE IS LICENCED AS IS.
If any materials or media in this package are defective, return

them within 90 days of the original date of purchase and Novell

will replace them at no charge. The right to use the Software is

granted without any further warranty, condition, representation
or other term express or implied relating to the performance,

quality or fitness for use of the Software or written materials

accompanying the Software. Novell shall not be liable for any

loss or damage of any kind (other than personal injury or death)
arising from use of the Software or accompanying written

materials or from errors, deficiencies or faults therein, whether

such loss or damage is caused by negligence or otherwise.

CUSTOMER SUPPORT
Subject always to Novell's current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement shall be unlawful, void, or for any
reason unenforceable, then that provision shall be deemed severable
from this Agreement and shall not affect the validity and
enforceability of any of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement or
special programs for education or charitable organisations, please
contact your local WordPerfect office or authorised distributor or
write WordPerfect, Applications Division of Novell, Inc. Attn. Sales
Center, 1555 N. Technology Way, Orem, Utah 84057-2399 U.S.A.,
or call 801/222-4200.



FOR PRODUCTS PURCHASED IN CANADA (ENGLISH)
SOFTWARE LICENSE AGREEMENT

GRANT OF RIGHTS
Novell, Inc (Novell), grants you the right to use the Software in the
quantity and on the platform(s) indicated on the Proof of Purchase
form you received in your Software package. If this Software is an
upgrade from a previous version of a Novell software product, you
may utilize either the current of prior version of the Software, but
never both versions at the same time. This Agreement supersedes any
prior version license and governs your use of the Software.

CLIENT SOFTWARE For computers or workstations attached to a
network, the quantity of Software "in use" is the number of user
mailboxes that you have, or intend to have on your network. For
computers or workstations attached to a public messaging system the
quantity of the Software "in use" is considered to be the greater of (i)
the maximum number of computers on which the Software is Loaded
at any one time, or (ii) the maximum number of computers on which
the Software is Stored.

MESSAGE SERVER SOFTWARE Message Server Software run on
a computer, workstation, or file server used as a message server
requires a single license for as many computers as necessary within a
single domain. A "domain" is a logical grouping of post offices
and/or gateways serviced by a single message server.

GATEWAY SOFTWARE Gateway Software is considered "in use"
when any portion of the Software is either loaded in memory or
virtual memory (Loaded) or stored on a hard disk or other storage
device (Stored).

You may make copies of the written documentation, which
accompanies the Software, in support of your authorized use of this
Novell software product. You may also make an archival copy of the
Software for each License obtained under this Agreement.

RESTRICTIONS
You may not rent or lease the Software without the written
permission of Novell. You may not decompile, disassemble, reverse
engineer, copy, create a derivative work or otherwise use the
Software except as stated in this Agreement. Irrespective of the
number of sets of media included with the Software, you are granted
the right to use the Software only in the quantity indicated on the
enclosed Proof of Purchase form. Certain qualifications may apply
to the purchase of this Software; when present, they are printed on
the Software package and form part of this agreement.

HOME OR PORTABLE COMPUTER PROVISION
You are authorized to use a copy of the Software on a home or
portable computer, as long as the extra copy is never Loaded at the
same time the Software is Loaded on the primary computer on
which you use the Software.

If you have licensed this Software under an education or charitable
institution pricing program, you may not create an extra copy of the
Software under this provision for use on a home or portable
computer.

LIMITED WARRANTY/LIMITATION OF LIABILITY
This Software is licensed AS IS. IF FOR ANY REASON YOU
ARE DISSATISFIED WITH IT, RETURN THE SOFTWARE,

INCLUDING ALL MATERIALS, WITH PROOF OF

PURCHASE TO NOVELL WITHIN 90 DAYS OF THE DATE

OF PURCHASE FOR A FULL REFUND. If any materials or
media in this package are defective, return them within 90 days

of the date of purchase, and they will be replaced at no charge.

THESE WARRANTIES ARE IN LIEU OF ANY OTHER

WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND

FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT

WILL NOVELL BE LIABLE TO YOU FOR DAMAGES,

INCLUDING ANY LOSS OF PROFITS, LOST SAVINGS, OR
OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES

ARISING OUT OF YOUR USE OF OR INABILITY TO USE

THE SOFTWARE, EVEN IF NOVELL OR AN AUTHORIZED

NOVELL REPRESENTATIVE HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

Some jurisdictions do not allow excluding or limiting implied
warranties or limiting liability for incidental or consequential
damages, and some jurisdictions have special statutory consumer
protection provisions which may supersede this limitation. As a
result, this limitation of liability may not apply to you if prohibited
by the laws of your jurisdiction.

CUSTOMER SUPPORT
Subject always to Novell's current support policies, Novell will
attempt to answer your technical support request concerning the
Software; however, this service is offered on a reasonable efforts
basis only, and Novell may not be able to resolve every support
request. Novell supports the Software only if it is used under
conditions and on operating systems for which the Software is
designed. Current support policies may change from time to time
without notice.

GENERAL
If any provision of this Agreement is found to be unlawful, void, or
unenforceable, then that provision shall be severed from this
Agreement and will not affect the validity and enforceability of any
of the remaining provisions.

ANY QUESTIONS?
If you have any questions concerning the terms of this Agreement,
please refer to the Questions and Answers which follows this
Agreement. If you have further questions about this Agreement or
about special programs for educational or charitable organizations,
please write to WordPerfect, Applications Division of Novell, Inc.
Attn. Sales Center, 1555 N. Technology Way, Orem, Utah 84057-
2399, or call (801) 225-5000.



CONTRAT DE CONCESSION DU DROIT D'UTILISATION
DES LOGICIELS EN VERSION FRANÇAISE ACHETÉS AU CANADA

TERMES ET CONDITIONS D'UTILISATION
Novell, Inc. (Novell), vous concède le droit d'utiliser le Logiciel,
conformément au nombre de copies et à la plate-forme spécifiés par le
Formulaire de preuve d'achat inclus dans le coffret du Logiciel. Si le
Logiciel constitue une mise à jour d'un produit de WordPerfect, Novell
vous concède le droit d'utiliser la présente version ou la version antérieure
du Logiciel, mais non ces deux versions simultanément. Le présent
Contrat de concession annule ou remplace tout contrat antérieur.

LOGICIEL CLIENT Sur les ordinateurs ou stations de travail connectés
à un réseau, le nombre de copies du Logiciel réputées «utilisées»
correspond au nombre maximum de boîtes aux lettres que vous êtes
autorisé à installer. Sur les ordinateurs ou stations de travail connectés à
un système de messagerie publique, on considérera que le nombre de
copies du Logiciel réputées «utilisées» correspond au nombre maximum
d'ordinateurs sur lesquels le Logiciel est chargé en mémoire
simultanément, ou au nombre maximum d'ordinateurs sur le disque dur
desquels le Logiciel est enregistré.

LOGICIEL DE SERVEUR DE MESSAGES Une seule licence est
requise pour utiliser le Logiciel sur un serveur de messages, ou sur un
ordinateur, poste de travail ou serveur de fichiers faisant office de serveur
de messages, desservant tous les ordinateurs d'un domaine. Un
«domaine» est le regroupement logique de plusieurs bureaux de poste
et/ou passerelles gérés par un seul serveur de messages.

LOGICIEL DE PASSERELLE Destiné aux ordinateurs ou stations de
travail non connectés à un réseau, ou aux serveurs de réseau, le Logiciel
est réputé «utilisé» lorsqu'il est intégralement ou partiellement chargé en
mémoire vive ou en mémoire virtuelle, ou bien enregistré sur le disque
dur ou tout autre dispositif de stockage.

Vous êtes autorisé à copier la documentation écrite, qui accompagne le
Logiciel, pour assister l'utilisation légale du Logiciel. Vous pouvez aussi
réaliser une copie d'archive du Logiciel pour chaque licence couverte par
le Contrat.

RESTRICTIONS
Vous ne pouvez en aucun cas louer ou céder en location le Logiciel sans
l'accord écrit de Novell. Vous ne pouvez en aucun cas décompiler,
démonter, inverser, reproduire, créer une oeuvre dérivée, ou autrement
utiliser le Logiciel en dehors des cas expressément prévus dans ce contrat.
Quel que soit le nombre de supports inclus avec le Logiciel, vous n'êtes
autorisé à utiliser que le nombre de copies indiqué sur le Formulaire de
preuve d'achat. L'achat de ce Logiciel peut être réglementé par des
conditions spéciales, imprimées sur l'emballage contenant le Logiciel.

DISPOSITIONS RELATIVES AUX ORDINATEURS PERSONNELS ET
AUX PORTABLES
Vous êtes autorisé à utiliser une copie supplémentaire du Logiciel sur un
ordinateur personnel ou un ordinateur portable. Cette copie ne doit en
aucun cas être chargée sur cet ordinateur personnel ou portable lorsque le
Logiciel est déjà chargé sur votre ordinateur principal.

Si le Logiciel a été acheté dans le cadre d'un programme d'éducation ou
caritatif, vous n'êtes pas autorisé à réaliser une copie supplémentaire du
Logiciel pour votre ordinateur personnel ou portable.

GARANTIES-LIMITATIONS DE RESPONSABILITÉS
CE LOGICIEL VOUS EST CONCÉDÉ EN LICENCE EN L'ÉTAT ; SI
POUR UNE RAISON QUELCONQUE, VOUS N'ÊTES PAS
SATISFAIT, VOUS DISPOSEZ D'UN DÉLAI DE 90 JOURS, À
COMPTER DE LA DATE D'ACHAT, POUR RETOURNER LE
LOGICIEL, Y COMPRIS TOUS COMPOSANTS RELATIFS,
ACCOMPAGNÉ DU FORMULAIRE DE PREUVE D'ACHAT À
VOTRE REVENDEUR, ET VOUS SEREZ INTÉGRALEMENT
REMBOURSÉ. En outre, Novell s'engage à remplacer gratuitement toute
disquette ou élément défectueux contenu dans l'emballage qui sera
retourné dans un délai de 90 jours, à compter de la date d'achat.

TOUTE AUTRE GARANTIE, EXPRESSE OU IMPLICITE, Y
COMPRIS TOUTE GARANTIE IMPLICITE D'APTITUDE À LA
COMMERCIALISATION OU D'APTITUDE À UNE UTILISATION
PARTICULIÈRE, EST EXPRESSÉMENT EXCLUE. EN AUCUN
CAS, NOVELL NE SAURAIT ÊTRE RESPONSABLE DES
DOMMAGES DIRECTS OU INDIRECTS, Y COMPRIS TOUTE
PERTE DE PROFIT OU DE BÉNÉFICE OU AUTRES DOMMAGES
INDIRECTS OU ACCESSOIRES CAUSÉS PAR L'UTILISATION OU
L'IMPOSSIBILITÉ D'UTILISATION DU LOGICIEL ET CE, MÊME
SI NOVELL OU L'UN DE SES REPRÉSENTANTS AGRÉÉS A ÉTÉ
AVERTI DE LA POSSIBILITÉ DE TELS DOMMAGES.

Certaines juridictions ne permettent pas l'exclusion ou la limitation de
garantie implicite ou la limitation de responsabilité pour des dommages
indirects ou accessoires. En outre, certaines juridictions prévoient des
dispositions particulières relatives à la protection du consommateur,
lesquelles pourraient remplacer les dispositions qui précèdent. En
conséquence, la limitation de responsabilité peut, conformément à la loi
en vigueur dans votre juridiction, ne pas vous être applicable.

ASSISTANCE TECHNIQUE
Dans le cadre de sa politique d'assistance technique, Novell s'efforcera de
répondre aux questions d'ordre technique concernant le Logiciel.
Cependant, il est convenu que ce service ne constitue qu'une obligation
de moyen et que Novell ne saurait satisfaire toute demande d'assistance.
Novell ne supportera le Logiciel que dans la mesure où celui-ci est utilisé
dans les conditions et selon les configurations matérielle et logicielle pour
lesquelles il a été conçu. Les services offerts par l'Assistance technique
peuvent être altérés sans préavis.

GÉNÉRAL
Au cas où une disposition quelconque de ce contrat serait illégale, nulle
ou non exécutoire, pour quelque raison que ce soit, cette disposition sera
réputée non écrite, et la validité et le caractère exécutoire des autres
dispositions de ce contrat n'en seront pas affectés.

RÉPONSES À VOS QUESTIONS
Si vous avez des questions à propos de ce Contrat, ou à propos des
conditions spéciales accordées aux établissements scolaires et aux
organisations caritatives, veuillez contacter la filiale dont vous dépendez,
ou votre distributeur agréé, ou écrire à WordPerfect, Applications
Division of Novell, Inc., Attn. Sales Center, 1555 N. Technology Way,
Orem, Utah 84057-2399 U.S.A., ou appelez le (800) 321-2318.



Questions and Answers
Q. How do I license for the use of workstations located on my network?
Can I license based on concurrent access to the system?

A. Each defined user on the GroupWise messaging system is assigned a
mailbox for persistent storage of calendar and electronic messaging data.
Each mailbox must be licensed and is considered "in use" after it has
been defined. Regardless of whether the user is actually logged into the
post office, the mailbox is actively available for delivery of messages,
processing of server-based rules, and other messaging services.

Q. If I have three users who share a workstation (they work on rotating
shifts), do I need one license or three to cover their use of the software?

A. If each of the three users has an individual mailbox, then three
licenses are required. If all three users share the same mailbox (defined
by job function, perhaps, rather than individual user), then only one
license would be required.

Q. Do I need to worry about which user runs the various Client
versions of the GroupWise software? If I'm migrating my users from
DOS to Windows, do I need to modify my license for the software?

A. No. Because the licensing of Client software is done on a per-mailbox
basis, any platform version of the GroupWise network Client software can
be used to access a licensed mailbox.

Q. If I have a user who runs the Client software on more than one
workstation, do I need more than one license?

A. No. Only one license is needed to cover access to the licensed
mailbox from one or more workstations.

Q. Am I required to license resources?

A. No. The resources defined on the GroupWise system do not need to
be licensed.

Q. How can I tell how many licenses I need?

A. The Administration program provides a count of all mailboxes
installed on the post office, domain, and system. The number of
licenses for which you are responsible equals the number of mailboxes
installed on the part of the system that is under your jurisdiction.

Q. How do I license my users who use the Remote Client versions of
the software?

A. The Remote Client software is licensed by the same mailbox license
mechanism used by Network Clients. Any platform version of the
Remote Client software can be used without additional licensing to
access any licensed mailbox.

Q. Can my users have a copy of the software loaded on their home
computer and laptop computer as well as on their network computer?

A. Yes. As long as all of these workstations where the software is stored
are used to access the same licensed mailbox, they can all operate under
a single mailbox license.

Q. How is the Administration software licensed?

A. There is no license tied specifically to the Administration software.
It is provided in the Client package and can be used on any system that
contains licensed mailboxes.

Q. How are the multiple Message Server programs licensed?

A. The GroupWise Message Server software is licensed on a domain
basis by Message Server platform. Any and all Message Server programs
required for the operation of the GroupWise system on a supported
platform are licensed for use on a single domain. Additional Message
Server licenses are required for each additional domain serviced.

Q. Can I run the Message Server programs licensed under the domain
license on separate workstations or file servers?

A. Yes. As long as these programs are run to support the messaging
services of a single domain, they can run on one or more workstations
or file servers.

Q. If I want to run different platform versions of the Message Server
programs on the same domain (such as MS and ADS OS/2, and OFS
NLMs), do I need one license or two?

A. In this case, even though the servers are supporting a single domain,
you would need two Message Server licenses because the Message Server
is licensed by platform and two platforms of Message Servers programs
would be in use.

Q. How are the GroupWise gateways licensed?

A. The GroupWise gateway software is licensed on a per-installation
basis using the "loaded" and "stored" conditions previously described.
Each occurrence of each gateway installed must be licensed.

Q. Do I need multiple gateway licenses of any single gateway to service
the post offices and domains on my system?

A. Generally, one gateway per system will be sufficient to service the
needs of the entire system. If only one gateway is installed, it only needs
a single license and any user on the system can use its services.

Q. We tunnel through the Internet using the SMTP gateway. How
many SMTP gateway licenses are required?

A. One license is required for each installation of that gateway. To
connect two sites via gateway tunneling, two installed and licensed
gateways must be used.

Q. 4.1 versions of the GroupWise gateways now allow me to run
multiple gateway processes on a single defined gateway service. How
many licenses do I need to support this configuration?

A. Where two or more gateway processes are "loaded" and executing as
separate processes, each must be licensed.
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Starting GroupWise

Before you begin using GroupWise 4.1 for Windows, formerly known as WordPerfect
Office, you will need to run the GroupWise Setup Program. You must first be in the
Windows Program Manager. The way GroupWise is installed depends on whether
you are updating from WP Office 4.0 or installing GroupWise for the first time.

Upgrading from
WP Office 4.0

If you are currently running WP Office 4.0 or 4.0a, you will get an upgrade message
when your system administrator upgrades to GroupWise on the network. The upgrade
message prompts you to install GroupWise 4.1.

If you are running WP Office from the network, GroupWise updates your Button Bars
and preferences. It also installs WPCSET.BIF in place of the WP Office .INI files and
the TrueType fonts necessary for WP Characters.

If you are running WP Office from your hard drive, GroupWise opens the GroupWise
Install program so you can choose a standard or custom installation. Go to Running
the Setup Program below and start at step 3 for instructions. The GroupWise Install
program updates your Button Bars and preferences. It also installs WPCSET.BIF in
place of the WP Office .INI files.

Running the Setup
Program

Your system administrator should already have told you the location of the setup
program (SETUPWIN.EXE). You need to know the location of the program before
continuing.

1 Make sure you are logged in as yourself at your computer.

2 From the Program Manager window, choose the File menu, choose Run, then type the
path to SETUPWIN.EXE in the Command Line box.

The path will look similar to this: N:\OFFICE\OFWIN40\SETUPWIN.EXE.

3 Choose OK to start the setup program.

4 Select the type of install you want in the GroupWise Install dialog box.

When the installation is complete, select the GroupWise program group for the
GroupWise program icons. If you want to place the GroupWise 4.1 item icons in a
different group, select the group from the pull-down list.

5 Choose OK.

Starting GroupWise 15



Starting
GroupWise 4.1 for
Windows

To start GroupWise,

1 Double-click the GroupWise program item icon in the GroupWise group.

2 When the Password dialog box appears, type your password if one has been assigned
to you, then choose OK.

or

If you don’t know your password, see your system administrator.

The GroupWise Main Window should now be displayed on your monitor. The Main
Window lets you open other windows to view incoming and outgoing items, open calendar
views for managing your schedule, and open views for sending mail, appointments, tasks,
notes, and phone messages. See A Brief Tour below.

Pull-down menus

Double-click an icon to open a

window.

The Shelf lets you place

views, macros, or applications

in the Main Window so you

can open them quickly.

The title bar shows the window

name.

Double-click icon button to open

the new item view displayed in

the pop-up list.

The pop-up lists let you choose

the view each icon button opens.

A Brief Tour

Welcome to GroupWise 4.1 for Windows! This section provides you with a quick overview
of GroupWise 4.1 and helps you get acquainted with this guide.

The Main Window With the intelligence of GroupWise, you now have the tools you need for electronic
messaging, as well as time and task management.

The Main Window is where you can access all the following tools:

Shelf

Main Window

The In Box displays all incoming messages and requests. When your In Box icon
displays an envelope, that means there are new items to read and act on.

The Out Box displays all messages and requests you send. You can use the Out
Box to retract items you have sent, or to find out if an item has been delivered, opened,
accepted, declined, deleted, and so forth.

When your Trash icon appears full, it means you have deleted items from your
Calendar, In Box, or Out Box. Until it is emptied, the Trash stores all your deleted items,
allowing you to recover an item if you change your mind.
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The Calendar is a personal planner and time management tool. There are several
predesigned calendar formats you can select from to manage your appointments, tasks,
and notes.

Send Mail is your basic messaging tool. However, you can also attach text files,
graphics, applications, sounds, movies, OLE objects, and GroupWise views to mail
messages and other item types.

Schedule is your personal and group appointment tool. People and resources (such
as conference rooms, company vehicles, and overhead projectors) can all be scheduled
for an event quickly and easily.

Assign Task can be used as a project management tool which makes organizing a
group effort as easy as identifying the tasks, people, and time frame needed to accomplish
the goal. You can also create a personal task list with this tool.

Write Note lets you post reminders, announcements, or requests for other users, as
well as create personal reminders for yourself. Use notes as reminders about upcoming
deadlines, holidays, and so forth.

Use Phone Message to send paperless phone or “While You Were Out” messages.

Shelf: Use the Shelf to customize GroupWise to your needs. For example, you can place
an icon from the Main Window or an application icon on the Shelf. The Shelf icons let you
open views, macros, filtered boxes, and launch applications quickly. See Shelf in the
GroupWise 4.1 for Windows Reference.

In Box and Out
Box Icons

The messages, appointments, or requests you send are called items. The following table
helps you identify and understand the icons associated with each item.

Items Unopened Item Icon Opened Item Icon

Mail [Icon not shown] [Icon not shown]
Appointment [Icon not shown] [Icon not shown]
Task [Icon not shown] [Icon not shown]
Note [Icon not shown] [Icon not shown]
Phone Message [Icon not shown] [Icon not shown]

Items with accompanying attachments such as files or graphic documents are marked with
a paper clip icon in the In Box. An item with a sound attachment is marked with a speaker
icon.

Paper clip icon

Speaker icon

GroupWise Views A view lets you display information. GroupWise includes three types of views.

Group views let you send mail messages, appointments, tasks, notes, or phone messages
to one or more users, including yourself if you want.

Personal views let you place appointments, tasks, or notes which involve only you, into
your Calendar.

A Brief Tour 17



Using This Guide The User’s Guide is divided into two clear and simple sections to help you quickly learn the
tools of GroupWise:

Using GroupWise Basics: Refer to this section when you need quick, how-to information
on basic tasks. The tasks are grouped according to the icons in the Main Window.

Using GroupWise Remote: Explore this section for information on how to use GroupWise
Remote to communicate and manage your time and business tasks when you are away
from the office.

Mouse Actions You
Should Know

The table below lists some basic mouse actions you should know. If you use a left-handed
mouse, reverse the left or right instructions.

Action Mouse

Point Move the mouse until the tip of the pointer is positioned on the item
you want.

Release Lift your finger from the mouse button.

Click Press and release the left mouse button.

Right-click Press and release the right mouse button.

Shift-click Hold down the Shift key and click the left mouse button.

Ctrl-click Hold down the Ctrl key and click the left mouse button.

Double-click Rapidly click the left mouse button twice.

Drag Hold down the left mouse button, move the mouse, then release the
button.

Reference Manual Because of the power and flexibility of GroupWise, not all features or applications of the
program can be covered in this guide. By using the GroupWise 4.1 for Windows
Reference (subsequently referred to as the reference manual), you can find the answers
you will need about the specific features and functions of GroupWise.

Conventions Icons

Some of the icons in GroupWise are unnamed in the interface. An icon within a step
guides you to the interface icon you need to choose to perform the task. The following
step shows what you might see in the manual.

1 Choose Proxy , then choose the name of the user you want to proxy.

Bolded Words
Bolded words in steps or explanations indicate what you choose or select in the step. The
following step shows what you might see.

1 Choose the File menu, then choose Preferences.

Getting Help

If you encounter problems using GroupWise, you can get help from several sources:

• Online Help
• Coaches
• QuickTour
• The Manuals
• Your System Administrator or Help Desk
• Customer Support
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Using Online Help Online Help gives you quick access to documentation without reaching for a manual. You
can access Help from wherever you are in GroupWise.

To access Help, simply choose the Help menu, or choose the Help buttons found in dialog
boxes, or right-click, then choose Quick Help.

Using the Help Menu
You can access any of the Help features below from the Help menu.

Menu Options Purpose

Contents Displays and explains a list of Help features. You can select
any underlined term to display the topic.

Search for Help On Use to open the Search dialog box and find Help topics by
keywords or phrases

What Is Switches the mouse and keyboard into a context-sensitive
mode which lets you click screen regions or press keystroke
combinations to get help.

How Do I Explains how to perform common tasks.

Coach Steps you through many common tasks.

Macros Explains macro basics, programming and product commands,
and user-defined dialog boxes.

About GroupWise Displays your network and program information.

Using QuickTour QuickTour is a short demonstration of GroupWise for Windows. As part of the installation
process, Setup asks if you want to view QuickTour. If you decide not to view it at that time,
or want to review it later, you can double-click the QuickTour icon on the Shelf.

Other Assistance If you need assistance beyond what the Help features and the GroupWise manuals can
provide, contact your Help Desk or your system administrator. If they cannot solve your
problem, these individuals can contact Customer Support.
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Reading Items

All incoming items appear in your In Box. Item types include mail messages,
appointments, task, notes, and phone messages.

From the Main Window,

1 Double-click In Box .

2 Double-click the item you want to read in the Item list box.

Control-menu box

Item list box

If you are reading all your items, choose the Actions menu, then choose Read Next to
read the next item or Read Previous to read the previous item.

3 Choose Close to return to the In Box.

4 Double-click the Control-menu box shown above to return to the Main Window.

Tips and Hints Deleting Items Immediately

You can also delete items immediately after reading them. Choose the Actions menu,
then choose Delete while you’re in the item view.

or

Choose Delete if you’re in a mail or phone message view. See Deleting Incoming
Items under In Box.

Access and Proxy Lists
You don’t have to leave your items unattended if you expect to be away from your office
for an extended period. You can selectively grant rights to a proxy who can answer your
mail or other items on your behalf. See Letting a Proxy Manage Your Mailbox under
Sharing Mailboxes.

If you don’t want to give someone access to your In Box, you can create a rule that
forwards items to another user. See Rules in the reference manual.

Reading Attachments

An attachment is a file or OLE object which may contain text, graphics, applications,
sounds, or movies and is sent with an item.
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In the In Box or Out Box, items with attachments are marked with a paper clip icon. Items
with sound annotations are marked with a speaker icon.

Paper clip icon

Speaker icon

From your In Box or Out Box,

1 Right-click the item with attachments, then choose Read from the QuickMenu.

2 If you want to read an attached file, right-click the attachment in the Attach box, then
choose View Attachment from the QuickMenu.

or

If the item has no Attach box, choose to open the Attachments dialog box, select
the attachment you want to read, then choose View.

Lets you open the attachment in

another application, such as

WordPerfect for Windows

Lets you view the attachment

within GroupWise

Attachments dialog box

3 If you want to listen to a sound annotation, double-click the sound indicator.

Sound indicator

If there is no sound indicator on

the view, click the sound button to

list the attached sound files.

4 Double-click the Control-menu box to return to the In Box or Out Box.

Reading Attachments 23



Tips and Hints OLE Attachments
The Object Linking and Embedding (OLE) feature lets you include charts, graphics,
spreadsheets, sound clips and many other types of information created in other
applications as attachments that can be linked or embedded.

To open an OLE attachment, right-click the OLE object in the Attach box, then choose
Open. See OLE in the reference manual.

Running Other Applications
If you can’t view an attachment, you can open the attachment in another application such
as WordPerfect for Windows.

To open the attachment from the item view, right-click the attachment in the Attach box,
choose Open. If there is no application associated with the file, type the command line in
the Application to Run box. The command line consists of the path or directory of the
application, and the executable program filename. If you select Make this Association
Permanent, GroupWise will use the application you specify the next time you open a file
similar to the current file.

Type the command line here.

Printing Items and Attachments

Use Print to print an item or its attachments. You can also print the items in a calendar
format. See Tips and Hints below.

From any item view,

1 Choose the File menu, then choose Print.

Item

Attachments are marked by +.

To print the attachment from

the application it was created in

Your item is already highlighted in the Items box.

2 If you want to print the item, choose Print.

3 If you want to print the attachment, select the attachment in the Items box, then
choose Print.

When you are printing the attachment, the Attachment Association dialog box opens if
the Print Attachment From Associated Application check box is selected. The
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application that GroupWise will run to print the attachment is displayed in the Application
to Run text box. Printing from the application will retain all formatting codes.

Type a different path and

application filename here, if

desired.

If you select the Make this Association Permanent check box, attachments with the
same extension (such as .wpg) can be printed from the same application in the future
without bringing up the Attachment Association dialog box again. A Preference setting
also affects the display. See Tips and Hints below.

Choose OK to run the application and print the attachment.

4 When you are done with printing, choose Close to return to the In Box.

Tips and Hints Selecting Multiple Items

You can select several items and their attachments to print from the In Box, Out Box, and
the Print dialog box.

To select a continuous range of items, click the first item in the range, then Shift-click the
last item in the range.

To select non-continuous multiple items, Ctrl-click the items you want.

After selecting the items, proceed with the steps above.

Disabling the Attachment Association Prompt
From the Main Window, choose the File menu, choose Preferences, then double-click
Associations. Deselect the Prompt Before Running Associated Application check
box.

Printing Troubleshooting
If nothing prints, make sure your printer is selected and set up correctly. Choose File, then
choose Print Setup to select your printer, specify margins, paper source, paper size, font
orientation, and the number of copies you want to print. See Print Setup in the reference
manual.

Accepting or Declining Appointments, Tasks, and
Notes

Accept or Decline lets you inform the sender of an appointment, task, or note whether you
are available or not. Opened and unopened items are distinguished by icons. See A Brief
Tour under Getting Started.

The text descriptions of these items remain italicized in your Calendar until you have
accepted or declined the items.

From the In Box,

1 Double-click the item in the Item list box.
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2 Choose Accept or Decline .

Close allows you to respond later.

Appointment view

3 If you decline, you may want to type a comment in the Comment box, then choose OK.

GroupWise sends an accept or decline status to the sender’s Information window. See
Tracking Item Information under Out Box.

Tips and Hints Accepting with a Comment

If you want to type a comment to the sender when you accept an item, choose the Actions
menu, choose Accept with Comment, type a comment in the Comment box, then choose
OK.

Accepting or Declining from the Calendar
You can also accept or decline appointments, tasks, or notes from your Calendar. See
Accepting or Declining Appointments, Tasks, and Notes under My Calendar.

Deleting from the In Box
If you delete an item from your In Box, the sender’s Information window will display an
opened and a deleted status. If you want the sender of an appointment, task, or note to
receive an accepted or declined status, you should choose either Accept or Decline before
deleting the item.

Where Items are Moved to
When you accept an appointment, task, or note in your In Box, the item disappears from
your In Box. You can view the item in your Calendar. If you decline the item, it is moved
to your Trash. You can adjust the In Box Filter if you would like to see your accepted items
in the In Box. See Filter in the reference manual.

Undeleting
If you declined and deleted an item, but have now changed your mind, you can still
undelete and accept the item if you have not emptied the Trash. See Undeleting Items
under Trash.

Replying to Mail and Phone Messages

After reading a mail or phone message, the Reply feature lets you respond to the sender
immediately without having to select the sender’s name from the Address Book. You can
also reply to an appointment, task, or note. See Tips and Hints below.

After reading the message,

1 Choose Reply .
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2 Select Reply to Sender to send a reply to the sender only.

or

Select Reply to All to reply to the sender as well as all the recipients.

3 If you want to include the item’s text, select the Include Message Received from
Sender check box.

4 Choose OK, then type a message in the Message box.

The To box is already

addressed to the sender of the

original item.

Message box

The Subject box contains the

original subject with “-Reply”

added to the end.

5 Choose Send to send your reply.

6 Choose Close to return to the Main Window.

Tips and Hints Replying to Appointments, Tasks, and Notes

While accepting or declining an appointment, task, or note, you’ll be prompted to type in a
comment. To reply without accepting or declining, choose the Send menu, then choose
Reply. Continue with step 2 above.

If you want to add a comment when you accept an item, choose the Actions menu, then
choose Accept with Comment. The comment is not sent as a Reply. Instead, it appears
in the sender’s Information window.

Resending a Message
If you want to resend basically the same message with minor changes, see Resending and
Rescheduling Items under Out Box.

Forwarding Items

When you want someone else to read the item you have just received, use Forward.
When you forward an item, it is sent as an attachment to a mail message.

From the In Box,

1 Double-click the item you want to forward.
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2 Choose the Send menu, then choose Forward.

or

If you are in an opened mail view, choose Forward .

The subject remains the

same, except that

“-Forwarded” is added to the

end.

Message box

The message you are

forwarding appears as an

attachment in the Attach box.

3 Choose Address to open the Address Book.

4 Select recipients for the Send To, Carbon Copy, and Blind Copy boxes by dragging
their names to the appropriate boxes.

5 Choose OK.

6 Type a message in the Message box.

7 Choose Send to forward the item.

Tips and Hints Delegate

If you are unable to accept an appointment, task, or note, you can delegate the request
instead of forwarding the item. Delegating will send a delegated status to the sender’s
Information window. This way, the sender will know that you have transferred the
responsibility to another person. See Delegate in the reference manual.

Attachments and Object Linking and Embedding
If there are other files or objects you want to send with the item you’re forwarding, use the
Attach feature. See Attaching Files under Send Mail.

You can also embed or link an object or file in an item you are sending. See OLE in the
reference manual.

Deleting Incoming Items

You can delete any item from the In Box at any time. However, if you cannot accept a
scheduled item, you should consider using Decline rather than deleting the item from the
In Box. Deleting will only send a deleted status to the sender, and he or she will not know
if you’ve accepted or declined the request.

From the Main Window,

1 Double-click In Box .

2 Right-click the item you want to delete.
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3 Choose Delete from the QuickMenu.

Item list

QuickMenu

4 Double-click the Control-menu box to return to the Main Window.

Tips and Hints Selecting Multiple Items

You can also select multiple items to delete.

To select a continuous range of items, click the first item, then Shift-click the last item in
the range.

To select non-continuous multiple items, Ctrl-click the items.

Deleting an Opened Item
After reading an opened item, you can delete it immediately. To delete the opened item,
choose the Actions menu, then choose Delete.

or

Choose Delete if it is available in the item view.

Undeleting
If an item has been deleted by mistake, it can still be recovered if you haven’t emptied the
Trash. See Undeleting Items under Trash.

Creating Folders

Folders help you to organize and store your In Box and Out Box items. You can use
folders to group items by a specific task, project, person, or any other subject.

All the folders that you create are subfolders of the root folder. The Folder list contains the
same folders regardless of which view you are in, and any folder can contain subfolders.

Root folder

A plus (+) sign indicates the

presence of subfolders. Click

to open folders.

Subfolders

From your In Box or Out Box,

1 Choose the File menu, then choose Folders to open the Folders dialog box.

2 Select a parent folder in the Folder List box. The new folder you are creating will be
the subfolder of this parent folder.
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3 Choose Create to open the Folder Name dialog box.

4 Type the name of the new folder, then choose OK to add the folder to the Folder List
box.

5 Choose OK to return to your In Box or Out Box.

Tips and Hints Deleting Folders

To delete an unwanted folder and its contents, from the In Box or Out Box, right-click the
folder you want to delete. Choose Delete from the QuickMenu, select Folder(s) and
Contents, then choose OK.

Drag and Drop
You can use drag and drop to manipulate your folders. Drag and drop folders onto
another folder to make them subfolders.

To move an item in your In Box or Out Box from one folder to another, drag and drop the
item from the Item list box to the Folder.

Folder list box

Item list box
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Resending and Rescheduling Items

You can resend mail or phone messages, or reschedule appointments, tasks, and notes if
they are still in your Out Box. You may also want to retract the original item before
resending it. See Retracting Unopened Items under Out Box.

1 Double-click Out Box .

2 Select the item to resend or reschedule from the Item list box.

3 Choose the Send menu, choose Resend, then edit the old message or reschedule the
item.

4 Choose Send .

You will be prompted to retract the original item. Mail and phone messages cannot be
retracted if they have already been opened by the recipient(s). Appointments, tasks, and
notes can be retracted any time, even after they have been accepted.

5 Choose Yes if you want to retract the original item.

Tips and Hints Items in the Trash

Items in the Trash need to be undeleted before you can resend or reschedule them. See
Undeleting Items under Trash.

Calendar
To reschedule items from your Calendar, including personal items, see Rescheduling
Appointments, Tasks, and Notes under My Calendar.

Finding an Item
If you have a long list of items in your Out Box, use the Find feature to search for the items
you want to reschedule.

Select the first item in the Item list box, choose the Edit menu, then choose Find. In the
appropriate box, type the string of words or characters that matches the text in your item.
Choose Find Next to start the Find process. See Find in the reference manual.

Retracting Unopened Items

If the information in a mail or phone message has become outdated or is incorrect, you
can still retract the item if the recipient has not opened the item. You can also retract
appointments, tasks, or notes whether they have been opened or not.
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From the Out Box,

1 Right-click the item to open the QuickMenu, choose Delete.

2 Select All In Boxes to delete from the recipient’s In Box only.

or

Select All Mailboxes to delete from your Out Box and the recipient’s In Box.

3 Choose OK to retract the item.

4 Double-click the Control-menu box to return to the Main Window.

Tips and Hints Before Retracting

Before retracting, you may want to check the item’s status to see if it is still unopened. See
Tracking Item Information under Out Box. A mail or phone message can be retracted only
if it is unopened.

Resending or Rescheduling
If you plan to resend or reschedule an item, you don’t have to retract the item as a
separate step. While resending or rescheduling, you will be prompted to retract your
original item. See Resending and Rescheduling Items under Out Box.

Deleting Outgoing Items

You should periodically delete any obsolete or unwanted items from your Out Box.

From the Main Window,

1 Double-click Out Box .

2 Right-click the item you want to delete.

3 Choose Delete from the QuickMenu.

Control-menu box

Item list box

The QuickMenu is activated

by the right mouse button.
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4 Choose OK to delete the item from This Out Box.

Delete from your Out Box only

Delete from your Out Box and

recipients’ In Boxes

Delete from all recipients’ In

Boxes

5 Double-click the Control-menu box to return to the Main Window.

Tips and Hints Cleanup Options

If you want GroupWise to periodically delete items from your In Box, Out Box, and
Calendar, choose the File menu from the Main Window, choose Preferences, then
double-click Cleanup. Select Auto-Delete After from the Mail and Phone, and
Appointment, Task, and Note group boxes, then type in the number of days for the
periodic cleanup.

[Illustration not shown]

Selecting Multiple Items
You can also select multiple items to delete from the In Box or Out Box.

To select a continuous range of items, click the first item in the range, then Shift-click the
last item in the range.

To select non-continuous multiple items, Ctrl-click the items.

Undeleting
If an item has been deleted by mistake, you can still recover it if you haven’t emptied the
Trash. See Undeleting Items under Trash.

Tracking Item Information

From the Out Box, you can find out what actions have been performed on the items you’ve
sent.

For example, when a recipient opens an item from you, forwards the item to a GroupWise
user, then delegates the item to another user, GroupWise will inform you of these three
actions and when they occurred.

From the Main Window,

1 Double-click Out Box .
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2 Double-click the item you want information on.

Control-menu box

Delivery date and time

information

Opened date and time

information

List of recipients

Info window

3 Double-click the Control-menu box to return to the Out Box.

4 Double-click the Control-menu box to return to the Main Window.

Tips and Hints Information You Can Access

The Information window for an item you have sent includes the following information about
the current item.

• Item name, post office, and the sender’s user ID

• Date and time the item was sent

• Subject of the item

• List of all recipients by post office

• List of attached files including the MESSAGE file (The size of each file and the date
and time it was last saved are also included.)

• Status information about the recipient’s post office (including date and time the
message was delivered to the recipient’s post office and the route used)

• Status information about the item in the recipient’s In Box, including the date and time
the item was delivered, opened, accepted, completed, delegated, deleted, forwarded,
or emptied from the Trash

Accessing the Information Window Elsewhere
You can also access the Information window from your Calendar or within an item. After
selecting an accepted item, choose the Actions menu, then choose Info.

In Box Information Window
The In Box Information window provides information about the sender, the item that was
received, and any options that were selected for a specific item when the item was
created.

Resending
If you need an answer to an item, but the recipient has deleted the item without replying,
you can resend it. See Resending and Rescheduling Items under Out Box.
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Undeleting Items

You can still recover items you have deleted from your Calendar, In Box, and Out Box if
they have not been emptied from the Trash.

From the Main Window,

1 Double-click Trash .

Control-menu box

Item list box
Scroll bar

2 Select the item to undelete from the Item list box.

3 Choose the Edit menu, then choose Undelete to recover the item.

4 Double-click the Control-menu box to return to the Main Window.

Tips and Hints Where Undeleted Items Appear

An undeleted item will reappear in the Calendar or in the In Box or Out Box folder it was
deleted from. If the folder the item was deleted from no longer exists, the undeleted items
will reappear in the root folder.

Emptying Your Trash

Emptying your Trash lets you permanently delete all the items currently in the Trash.
Once you have emptied the Trash, you will not be able to recover any items. To discard
only selected items, see Selecting Multiple Items under Tips and Hints below.

From the Main Window,

1 Double-click Trash .

2 Choose the Edit menu, then choose Empty Trash to delete all items from your Trash.

3 Choose Yes if you are sure that all items in the Trash should be deleted.

All the items in the Trash will be deleted. This process may take some time.

Tips and Hints Selecting Multiple Items

You can empty selected item(s) from the Trash.

To select a continuous range of items, click the first item in the range, then Shift-click the
last item in the range.

To select non-continuous multiple items, Ctrl-click the items.

After selecting your items, right-click the selected range to display the QuickMenu, then
choose Empty Selected Items.
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Emptying Your Trash Automatically
You can specify the number of days that items should stay in the Trash before they are
automatically emptied.

From the Main Window, choose the File menu, choose Preferences, then double-click
Cleanup. Select Automatic After from the Empty Trash group box, specify the number of
days, then choose OK. Be aware that your system administrator can set and lock this
option.

Empty Trash group box

Click these arrows to set the

number of days an item is in the

Trash before it is emptied.

You can recover an item you have placed in the Trash if the Trash has not been emptied.
See Undeleting Items under Trash.
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Accepting or Declining Appointments, Tasks, and
Notes

Use Calendar to manage your personal schedule and business tasks. You can read and
respond to any incoming requests from your Calendar. There are several pre-designed
calendar views. The Week View is especially useful, because it allows you to look at all
three types of items on a weekly basis.

You can accept or decline appointments, tasks, and notes from either the In Box or the
Calendar.

From the Main Window,

1 Choose the My Calendar pop-up list, then choose a calendar view.

Control-menu box

The ? and italicized text

indicate a group item that

hasn’t been accepted yet.

Appointments list box

Notes list box

Tasks list box

Personal items are not

marked by any icon.

Week view

2 Double-click the text of a group item in the Appointments, Tasks, or Notes list box to
open the item view.

3 Choose Accept or Decline .

4 If you decline, you may want to type a comment in the Comments box, then choose
OK.

GroupWise sends an accept or decline status along with any comments to the sender’s
Information window. See Tracking Item Information under Out Box.

5 Double-click the Control-menu box to return to the Main Window.

Tips and Hints Accepting with a Comment

If you want to type a comment to the sender when you accept an item, choose the Actions
menu, choose Accept with Comment, type a comment in the Comment box, then choose
OK.

About Tasks
Uncompleted tasks are carried forward to the next day in your Calendar until you mark the
tasks as completed. See Completing Tasks and Routed Items below. When a task
becomes overdue, it is displayed in red in your Calendar.
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QuickMenu
If you already know the nature of an appointment or request and want to respond without
opening the item, right-click the item, then choose Accept or Decline from the
QuickMenu.

Rescheduling Appointments, Tasks, and Notes

You can reschedule a group item from the Calendar or Out Box if you were the original
sender of that item. You cannot reschedule an item if someone else scheduled it. You
may also retract the original item before rescheduling it. See Retracting Unopened Items
under Out Box.

From the Main Window,

1 Choose the My Calendar pop-up list, then choose a calendar view.

Monthly Calendar

Day view

2 Double-click the text of the item to be rescheduled to open the item view.

3 Choose the Send menu, then choose Resend.

4 Choose Start Date or , then make the necessary date or time changes.

5 Choose Send for group items.

6 Choose Yes to Retract Original Item.

7 Double-click the Control-menu box to return to the Main Window.

Tips and Hints Dragging an Item onto the Monthly Calendar

If a calendar view displays the Monthly Calendar, you can drag the item you want to
reschedule to another date in the Monthly Calendar. Release the item when the desired
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date is selected. You can also reschedule an item by dragging it to another time or day
displayed in your calendar view.

Monthly Calendar

Busy Search
If you drag to reschedule a group item, you will be asked if you want to perform a busy
search and/or edit the item before rescheduling. To find out which days and times are
available for all participants and resources, see Using Busy Search under Schedule.

Making Other Changes
Besides changing the date and time when you reschedule an item, you can also add
recipients to the To box, change the location in the Place box, and edit the text in the
Message box.

Completing Tasks and Routed Items

Tasks that have not been marked as completed will be carried over to the next day on your
Calendar. In addition, overdue tasks turn red if they are not marked completed.
Completed tasks are distinguished by a check mark in your Calendar.

Routed tasks and mail also need to be marked completed before they can be sent to the
next person. See Routing Slips in the reference manual.

From a calendar view that shows your Tasks list,

1 Point in the check box on the left of the task.

Day view
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Your pointer will turn into a check mark.

2 Click the check box.

Tips and Hints From a Task or Routed Item View

You can also mark a task or a routed item as completed from within the item view. Select
the Completed box.

Completed box

Sender Notification
If another user assigned the task to you, GroupWise notifies the sender when you mark
the task completed, if the sender selected the Return Notification option. A completed
status, including the date and time the task was marked completed, is also placed in the
sender’s Information window. See Tracking Item Information under Out Box.

Unmarking a Task
If you accidentally marked the wrong task as completed, you can “uncomplete” the task by
clicking the Completed box again.

Printing the Calendar

Use Print Calendar to print appointments, tasks, and notes in different formats and page
sizes.

From the Main Window or any calendar view,
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1 Choose the File menu, then choose Print Calendar.

Prints a title at the top of the

first page

Send the Calendar to the

printer.

Saves the Calendar as a

WordPerfect 5.1 file.

Sample box

2 Select a format from the Calendar Type group box.

A graphic is displayed in the Sample box to show you what the format looks like. The
format you select affects the options you can select from the Print Size and Attributes
group boxes.

3 Select a size from the Print Size group box.

4 If you want to change the first date to print, choose , select a new start date, then
choose OK.

5 Specify the number of days, weeks, or months you want in the Number of Days,
Number of Weeks, or Number of Months box, depending on the format you have
chosen.

6 Select the Attributes that apply.

7 Select the Contents options that apply.

8 Select Windows Printing.

9 Choose OK to print the Calendar.

Tips and Hints Contents Options

Contents Option Description

Places Prints the location where the appointment is scheduled

End Times Prints the time when an appointment is scheduled to end

Separator Lines Prints lines between the scheduled appointments

Deadlines Prints the date and time tasks are due

Include Completed Prints tasks that have been marked completed

Explanations Prints the text from the Message box of appointments, tasks,
or notes

Print to Gateway
You can select this option in the Print Calendar dialog box if you have purchased and
installed the Fax/Print Gateway. You will need to type the appropriate address string in
the Gateway box. See your Fax/Print Gateway guide for more information.
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Sending Mail

Besides sending a message, you can also attach text files, graphics, sounds, and OLE
objects to the mail you send to other GroupWise users. See Attaching Files under Send
Mail.

From the Main Window,

1 Choose the Send Mail pop-up list, then choose a mail view.

Control-menu box

Subject box

Message box

2 Type the user IDs in the To field, separating the IDs with commas, then go to step 5.

or

Choose Address to open the Address Book.

3 Select recipients for the Send To, Carbon Copy, and Blind Copy boxes by dragging
their names to the appropriate boxes.

4 Choose OK.

5 Type the subject in the Subject box.

6 Type a message in the Message box.

7 Choose Send .

Tips and Hints Searching for a User’s Name

Searching for a user’s name in the Address Book is easy. When your Address Book is
opened, type the first letters of the user’s name and a name matching those letters will be
highlighted. Press the space bar to search subsequent fields. For example, if you have
several people with the last name Jones, type Jones, press the space bar, then type the
first name.

Be aware that the order of the last and first names is defined by your system administrator.
Your Address Book may display the first name before the last name.

Typing User IDs
Instead of using the Address Book to enter user IDs in the address boxes, you can type in
the user IDs. However, the following rules apply:

• You must spell user IDs correctly.
• You must separate user IDs with commas.
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Personal Groups
To send the item to a personal group, choose Personal Groups in the Address Book,
then double-click the group you want to send the item to. See Creating Personal Groups
under Send Mail.

Attaching Files

You can attach text files, graphics, applications, sounds, movies, GroupWise items you’ve
saved, sent, or received, and many other types of information with any item you send.

From any item view,

1 Choose the File menu, then choose Attach File.

Current directory

The Files list box shows the

files in the current directory.

Directories list box

2 Use the Files list box and Directories list box to locate the file you want to include in the
item.

3 Double-click the file to attach it to the item.

4 Choose Send for group items or OK for personal items.

Tips and Hints Selecting Multiple Attachments

There is no limit to the number of files you can attach to an item. The only limit is memory
size.

From the Attach File dialog box, click the first file in a continuous range of files, then Shift-
click the last file in the range.

To select a non-continuous range of files, Ctrl-click the files you want to include.

Viewing Attachments
If you are in an item view without an Attach box, and you would like to see your attached
file(s), choose the File menu, then choose View Attachment.

Attaching GroupWise Items
When you attach a GroupWise item to the item you are sending, the recipient can open
the attached (encapsulated) item and reply to the original sender. This is the same as
Forwarding the item.

To attach or forward an item, drag it from an item list and drop it on the new item view you
are sending.
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Sounds and OLE objects
You can annotate an item with sounds or attach embedded or linked objects. See
Attachments in the reference manual.

Creating Personal Groups

You can create your own groups of users and resources for addressing mail messages,
appointments, tasks, notes, and phone messages. For example, if you often need to
schedule a meeting for the same group of people, create a personal group instead of
selecting them individually from the Address Book each time you send an item.

Public groups, on the other hand, are created by the system administrator for every user to
access.

From the Main Window,

1 Choose the Send menu, choose Address Book, then choose Create/Edit Group>> to
open the Address Book.

2 Select the recipients by dragging the usernames to the Send To, Carbon Copy, and
Blind Copy boxes.

Include your name if you want to be a member of the group.

3 Choose Save Group, type a group name, then choose OK.

4 Choose OK to return to the Main Window.

Tips and Hints Resources

Resources are defined by your system administrator and may include conference rooms,
company vehicles, overhead projectors, and anything that can be scheduled. You can
include resources in your personal group. After selecting usernames, choose Resources,
then drag the desired resources to the Send To, Carbon Copy, or Blind Copy boxes.
Proceed with step 3 in Creating Personal Groups.

Removing a Name from a Group
You can delete a name from a personal group.

From your Address Book,

1 Choose Personal Groups, choose Create/Edit Group>>, then select the personal
group you want to edit.

2 Choose Retrieve/Edit Group, double-click the name you want to delete, then choose
Save Group.

3 Type the old group’s name, then choose Yes when GroupWise asks if you want to
replace the group name.
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Setting Temporary Mail Send Options

With Send Options, you can change the following for the mail message you are currently
sending.

Options Purpose

Status Information Tracks the actions performed on your mail and displays the
information in the Information window

Priority Controls the appearance of the mail in the mailboxes, so that
the priority of the item is apparent to the receiver

Expiration Deletes mail from your Out Box and the In Boxes of all
recipients who have not yet opened the message after a
number of days

Return Notification Alerts you each time a recipient opens, deletes, or
completes the mail

Reply Requested Asks recipients to reply to your mail within the number of
days specified or when convenient

Auto-Delete Deletes the mail from your Out Box as soon as all recipients
empty the mail from their In Boxes and Trash

Notify Recipients Alerts recipients with a sound, a dialog box, or an icon, if
they have loaded the Notify program

From a new mail view,

1 Choose the Send menu, then choose Send Options.

Sends a mail message

informing the sender when an

action is performed

Notifies the sender when a

recipient performs the action

to the right of the pop-up list

Notifies and sends mail to the

sender when an action is

performed

2 Select the options you want.

3 Choose OK, then complete and send your item.

Tips and Hints High Priority

When you have a high priority item and want to alert the recipient, select High in the
Priority group box. The item will appear red in the recipient’s In Box if the recipient has a
color monitor.

Advanced Send Options
Advanced Send Options let you change the delivery date and the security options if
needed. See Advanced Send Preferences in the reference manual.
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Scheduling Meetings

A meeting or group appointment can be scheduled for yourself and one or more
GroupWise users.

From the Main Window,

1 Choose the Schedule pop-up list, then choose a group appointment view.

2 Choose Address to open the Address Book.

3 Select the participants for the Send To, Carbon Copy, and Blind Copy boxes by
dragging their names to the appropriate boxes.

Include your name if you are a participant.

4 Choose Resources, double-click needed resources in the List box, then choose OK.

Resources (such as, conference rooms, projectors, and company vehicles) are defined by
your system administrator. If you select a location that your system administrator has
defined as a place in the Type column, the resource will appear in the Place box. Other
resources will appear in the To box along with the participant names.

Resources button

List box

Personal Groups button

5 Type the meeting description in the Subject box.

6 Type a message in the Message box.

7 Choose Start Date to select the meeting date, then choose OK.

8 Choose Time Input to select the meeting time, then choose OK.

9 Choose Send to send the appointment request.

The item is placed in the recipients’ Calendars and In Boxes, and in your Out Box.
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Tips and Hints Auto-Date

Scheduling recurring meetings is quick and easy when you use Auto-Date. See
Scheduling Recurring Items (Auto-Date) under Schedule.

Busy Search
To find out what days and times are available for all participants and resources, use Busy
Search. See Using Busy Search under Schedule.

Personal Groups
To send an item to a personal group, choose Personal Groups in the Address Book, then
double-click the group you want to send the item to. See Creating Personal Groups under
Send Mail.

Meeting Location
If the meeting place is not listed as a resource, type the location in the Place box of the
appointment view.

Scheduling Personal Appointments

Create a personal appointment to help you manage your schedule. For example, you may
want to create a personal appointment to remind you of meeting at a client’s office. The
item is placed only in your Calendar, not in your Out Box or in any other person’s In Box.

From the Main Window,

1 Choose the My Calendar pop-up list, then choose a calendar view that includes an
Appointments list.

2 Drag in the Appointments list to select the block of time you want to schedule, then
begin typing a subject.

A text box appears when you start typing.

3 When you are done, press Tab.

4 If you need to edit the subject or add a message, double-click the appointment to open
the personal appointment view.

Tips and Hints Auto-Date

You can schedule a recurring appointment using Auto-Date. See Scheduling Recurring
Items (Auto-Date) under Schedule.

Rescheduling
If your plans change, you can reschedule a personal appointment. See Rescheduling
Appointments, Tasks, and Notes under My Calendar.

Using Busy Search

You can avoid time conflicts in the meeting you are scheduling by using Busy Search to
check the schedule of each user and resource listed in the address fields.
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From the Main Window,

1 Choose the Schedule pop-up list, then choose Meeting.

2 Select the participants and resources from the Address Book. See Scheduling
Meetings under Schedule.

3 Choose Busy? .

4 Select the Start date, From and To times, and specify the number of days for the
Search Range in the Time and Range to Search group boxes.

5 Change Days to Search selections if necessary. Monday through Friday are already
selected for you by default.

6 Choose OK to open the Choose Appointment Time window.

The time cursor represents

the selected start time and

duration.

Combined schedule

Individual schedules

Selected start time and

duration are displayed here.

Shaded time intervals mark busy

times.

Click the dotted lines for

appointments starting at the

beginning of the hour.

Scroll arrows

7 Click the scroll arrows to move to an available day and time interval, then select the
desired time in the Combined schedule.

8 Choose OK to input selected date and time into your appointment view.

9 Complete and send the item.

Tips and Hints Dimmed Usernames

If a user’s name is dimmed, the Busy Search for that user is not complete. After the
search is complete, the name appears black.

Scheduling Recurring Items (Auto-Date)

You can schedule recurring appointments, tasks, or notes by using Auto-Date. There are
three Auto-Date creation methods:

• By Example lets you define items that recur on days of the month, days of the week, or
periodically (for example, a meeting that is scheduled on every month’s first Tuesday).

• By Formula lets you use previous WP Office 3.x functions to describe recurring dates.

• By Dates accommodates items that recur on an irregular basis (for example, events
that occur on specific holidays for several years).
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Only the steps using the By Dates method will be covered in this task. See Auto-Date in
the reference manual for more information on the other methods.

From a new appointment, task, or note view,

1 Choose Send, then choose Auto-Date.

2 Select the By Dates Creation Method.

Opens the Change Year

dialog box to go to a specific

year

Scrolls to the previous year

Scrolls to the next year

Month Heading

3 Select the dates that apply.

4 Choose OK, then complete and send the item.

Tips and Hints Selecting the Same Date for Several Months

You can select the same date for several months quickly. For example, to select the 15th of
every month, select the 15th of a month, then select the month heading of the other months. The
same date will be selected without you having to look for the 15th of each month.

Clearing Date Selections
If you made a mistake and want to start over in selecting your auto-dates, choose Reset to
clear all previous selections, then start again.

You can also click a date a second time to deselect a previously selected date.

Setting Temporary Appointment Send Options

With Send Options, you can change the following for the appointment you are currently
sending.

Options Purpose

Status Information Tracks the actions performed on your appointment and
displays the information in the Information window

Priority Controls the appearance of the appointment in the In Box
and Out Box, so that the priority of the item is apparent to
the receiver

Return Notification Alerts you each time a recipient opens, deletes, or accepts
an appointment

Notify Recipients Alerts recipients with a sound, a dialog box, or icon, if they
are running Notify.
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From a new appointment view,

1 Choose the Send menu, then choose Send Options.

Sends a mail message

informing the sender when an

action is performed

Notifies the sender when a

recipient performs the action

to the right of the pop-up list
Notifies and sends mail to the

sender

2 Select the options you want.

3 Choose OK, then complete and send your item.

Tips and Hints High Priority

When you have an important item and want to alert the recipient, select High in the Priority
group box. The item will appear red in the recipient’s In Box if he or she has a color
monitor.

Advanced Send Options
Advanced Send Options let you change the delivery date and the security options if
needed. See Send Options in the reference manual.
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Assigning Tasks

Organizing a group effort with GroupWise is as easy as selecting your recipients, a time
frame, and sending the request. You can also use Assign Task to send a task request to
an individual.

Tasks will be carried forward each day in the Calendar until you mark them as completed.
Overdue tasks turn red if you have a color monitor.

From the Main Window,

1 Choose the Assign Task pop-up list, then choose a group task view.

2 Choose Address to open the Address Book.

3 Select the participants for the Send To, Carbon Copy, and Blind Copy boxes by
dragging their names to the appropriate boxes.

Include your name if you are involved in the task.

4 Choose OK.

5 Type the subject in the Subject box.

6 Type a message in the Message box.

7 Choose Start Date , select the start date, then choose OK.

Go to the next month

Go to a previous month

Go to a previous year

Go to today’s date

Choose Auto-Date if you want to

schedule recurring items.

Go to the next year

The current due date is today’s date.

8 If you need to select another due date, choose Due On , select the due date, then
choose OK.

9 Choose Send to send the task to the recipients’ In Boxes and Calendars and to
your Out Box.

Tips and Hints Priority

You may assign a priority to the task, although it is optional. The task priority may consist
of a character followed by a number. The following are acceptable formats: A1, C2, B, 3,
and so forth.

In addition, you can change the item’s priority to High, Normal, or Low. See Setting
Temporary Task Send Options under Assign Task.
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Auto-Date
Scheduling recurring items is quick and easy when you use Auto-Date. See Scheduling
Recurring Items (Auto-Date) under Schedule.

Personal Groups
To send the item to a personal group, choose Personal Groups in the Address Book,
then double-click the group you want to send the item to. See Creating Personal Groups
under Send Mail.

Resending or Retracting Tasks
If your plans change and you need to reschedule a task which you assigned to other
users, see Resending and Rescheduling Items under Out Box. You may also retract the
task. See Retracting Unopened Items under Out Box.

Creating Personal Tasks

Personal Task lets you create a personal task list in your Calendar to keep track of things
you need to do. The tasks will be carried over each day on your Tasks list until you mark
them as completed. They will also turn red after the due date if you have a color monitor.

From the Main Window,

1 Choose the My Calendar pop-up list, then choose a view that includes a Tasks list.

2 Click the Tasks list, then start typing the task.

A text box appears as you start typing.

3 Press Tab when you are done.

4 To edit the task or assign a priority, double-click it to open the personal task view.

5 If you want to change the start date, choose Start Date , select the start date, then
choose OK.

Previous month

Previous year

Next month

Next year

The current due date is today.

6 If you want another due date, choose Due On , select the due date, then choose
OK.

7 Choose OK to add the item to your Tasks list in the Calendar.

Tips and Hints Priority

You may assign a priority to a task, although it is optional. The task priority may consist of
a character followed by a number. The following are acceptable formats: A1, C2, B, 3,
and so forth.
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Auto-Date
You can schedule a recurring task using Auto-Date. See Scheduling Recurring Items
(Auto-Date) under Schedule.

Rescheduling a Personal Task
If you need to reschedule a personal task for another day, see Rescheduling Items under
My Calendar.

Setting Temporary Task Send Options

With Send Options, you can change the following for the task you are currently sending.

Options Purpose

Status Information Tracks the actions performed on your task and displays the
information in the Information window

Priority Controls the appearance of the task in your Out Box and the
receiver’s In Box, so that the priority of the item is apparent
to the receiver

Return Notification Alerts you each time a recipient opens, deletes, accepts, or
completes the task

Notify Recipients Alerts recipients with a sound and a dialog box or icon, if
they are running the Notify program

From a new task view,

1 Choose the Send menu, then choose Send Options.

Sends a mail message

informing the sender when an

action is performed

Notifies the sender when a

recipient performs the action

to the right of the pop-up list
Notifies and sends mail to the

sender

2 Select the options you want.

3 Choose OK, then complete and send your item.

Tips and Hints High Priority

When you have a high priority item and want to alert the recipient, select High in the
Priority group box. The item will appear red in the recipient’s In Box if he or she has a
color monitor.

Advanced Send Options
Advanced Send Options let you change the delivery date and the security options if
needed. See Send Options in the reference manual.
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Sending Notes

A note is a message or reminder that can be scheduled for a specific day for you or one or
more GroupWise users. For example, you might want a note to appear as a reminder on a
specific day, such as a birthday, an upcoming deadline, holiday, and so forth.

From the Main Window,

1 Choose the Write Note pop-up list, then choose a group note view.

2 Choose Address to open the Address Book.

3 Select the recipients for the Send To, Carbon Copy, and Blind Copy boxes by dragging
their names to the appropriate boxes.

Include your name if you want the note to appear in your Calendar also.

4 Choose OK.

5 Type the subject in the Subject box.

6 Type a message in the Message box.

7 Choose , select the note date, then choose OK.

8 Choose Send .

Tips and Hints Auto-Date

You can create recurring notes by using Auto-Date. See Scheduling Recurring Items
(Auto-Date) under Schedule.

Personal Groups
To send the item to a personal group, choose Personal Groups in the Address Book,
then double-click the group you want to send the item to. See Creating Personal Groups
under Send Mail.

Rescheduling Notes
If your dates change, you can reschedule a note. See Rescheduling Appointments, Tasks,
and Notes under My Calendar.

Creating Personal Notes

When you create a personal note, it is placed in your Calendar. No one else will receive it.
Use a personal note to send yourself a reminder for a specific date, such as a birthday, an
upcoming deadline, or a holiday.
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From the Main Window,

1 Choose the My Calendar pop-up list, then choose a view that includes a Notes list.

2 Click the Notes list, then start typing the note.

A text box appears as you start typing.

3 Press Tab when you are done.

4 If you need to change the note, double-click it to open the personal note view.

Tips and Hints Auto-Date

Creating recurring notes is quick and easy when you use Auto-Date. See Scheduling
Recurring Items (Auto-Date) under Schedule.

Rescheduling Personal Notes
If your dates change, you can reschedule a note. See Rescheduling Appointments, Tasks,
and Notes under My Calendar.

Setting Temporary Note Send Options

With Send Options, you can change the following for the note you are currently sending.

Options Purpose

Status Information Tracks the actions performed on your note and displays the
information in the Information window

Priority Controls the note’s appearance in the In Box and Out Box,
so that the priority of the item is apparent to the receiver

Return Notification Alerts you each time a recipient opens or deletes the note

Notify Recipients Alerts recipients with a sound, a dialog box, or an icon, if
they are running the Notify program.

From a new note view,

1 Choose the Send menu, then choose Send Options.

Sends a mail message

informing the sender when the

action is performed

Notifies the sender when a

recipient performs the action

to the right of the pop-up list Notifies and sends mail to the

sender

2 Select the options you want.

3 Choose OK, then complete and send your item.
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Tips and Hints High Priority

When you have a high priority item and want to alert the recipient, select High in the
Priority group box. The item will appear red in the recipient’s In Box if he or she has a
color monitor.

Advanced Send Options
Advanced Send Options let you change the delivery date and the security options if
needed. See Send Options in the reference manual.
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Sending Phone Messages

Leaving a message about a phone call or office visit is now easy and paperless. The
Phone Message view resembles the information on a standard phone message pad.

From the Main Window,

1 Choose the Phone Message pop-up list, then choose a phone message view.

2 Choose Address to open the Address Book.

3 Double-click the recipient name in the List box to select the recipient, then choose OK.

4 Type the caller information in the Caller, Company, and Phone boxes.

5 Select the check boxes that apply to the message.

6 Type a message in the Message box.

7 Choose Send .

Tips and Hints Typing User IDs

If you type a user ID incorrectly in the To box, then choose Send, GroupWise notifies you
that the item cannot be delivered to that user. If the item is addressed to several users,
GroupWise tells you which user ID is incorrect.
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Setting Temporary Phone Send Options

With Send Options, you can change the following for the phone message you are currently
sending.

Options Purpose

Status Information Tracks the actions performed on your phone message and
displays the information in the Information window

Priority Controls the appearance of the phone message in the In
Box and Out Box, so that the priority of the item is apparent
to the receiver

Expiration Deletes the phone message from your Out Box and the In
Boxes of all recipients’ who have not yet opened the
message after a number of days

Return Notification Alerts you each time a recipient opens, deletes, or
completes the phone message

Reply Requested Asks recipients to reply to your phone message within the
number of days specified, or when convenient

Auto-Delete Deletes the phone message from your Out Box as soon as
all recipients empty the message from their In Boxes and
Trash

Notify Recipients Alerts recipients with a sound, a dialog box, or an icon, if
they are running the Notify program

From a new phone message view,

1 Choose the Send menu, then choose Send Options.

Sends a mail message

informing the sender when an

action is performed

Notifies and sends mail to the

sender

Notifies the sender when a

recipient performs the action to

the right of the pop-up list

2 Select the options you want.

3 Choose OK, then complete and send your item.

Tips and Hints High Priority

When you have a high priority item and want to alert the recipient, select High in the
Priority group box. The item will appear red in the recipient’s In Box if he or she has a
color monitor.
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Advanced Send Options
Advanced Send Options let you change the delivery date and the security options if
needed. See Send Options in the reference manual.
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Managing Another User’s Mailbox

Proxies can read and send items for other people. When you are selected as a proxy on
someone’s Access List, you can respond on that person’s behalf by accessing the Proxy
List.

From the In Box, Out Box, or any item or calendar view,

1 Choose , choose Proxy, then choose Users to open the Address Book.

2 Double-click the name of the person for whom you’ll proxy, then choose OK.

The view you have opened will now reflect the other user’s view. However, the username
you have added to your Proxy List will disappear when you exit GroupWise.

Tips and Hints Returning to Your Mailbox

To change the current view back to your own after acting as proxy for someone,

1 Choose , then choose your name.

Quick Proxy
After you have opened a view and chosen a user to proxy, drag the Title bar icon to the
Shelf. When you double-click that icon, GroupWise will open the view and choose the
user for you.

If Access Is Denied
If you tried to add a new user to your Proxy List, but an “Access to user denied” message
is displayed, check to make sure you are on that person’s Access List.

Letting a Proxy Manage Your Mailbox

Use the Access List to grant other users on your post office access to read, create, and
manage items and tools within your mailbox.
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From the Main Window,

1 Choose the File menu, choose Preferences, then double-click Access List.

List box
To apply selected rights to the

selected proxy

To add proxy names to your

Access List

2 Choose Add Users to open your Address Book.

3 Double-click the names of the people in the List box to whom you want give access to
your mailbox, then choose OK.

4 Select a proxy name(s), select the access rights you want to give the proxy, then
choose Apply.

The table below explains the rights you can give to a proxy.

Access Right Access to

Read Read the mail, appointments, tasks, or notes
you receive.

Write Write and send mail, appointments, tasks, or
notes in your name.

Subscribe To My Alarms Receive alarms for your appointments, if the
proxy subscribes to your alarms. See
Subscribe to Notify Preferences in the
reference manual.

Subscribe To My Notification Receive notification when you receive items, if
the proxy subscribes to your notification. See
Subscribe to Notify Preferences in the
reference manual.

Modify Preferences/Rules/Groups Modify the Preferences options. The proxy can
change your GroupWise setup, add or remove
proxies, and alter the rights you’ve assigned to
users in your Access List. This right also
grants the proxy the ability to create, edit,
delete, and run rules and to create, edit, and
delete groups. See Rules in the reference
manual.

Archive Items Place items in the Archive Directory and
retrieve them. If you give a proxy archive
rights, items archived by the proxy can be
stored on the proxy’s hard drive. You may not
have access to items archived by the proxy.

Read Messages Marked Private Read the items that you mark private.

5 Repeat step 4 until you have selected access rights for all your proxies, choose OK,
then choose Close to return to the Main Window.
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Tips and Hints Proxy

A proxy is another GroupWise user on your post office to whom you have granted
selective mailbox access rights. You grant these rights through the Access List.

Proxies can respond to items in your In Box on your behalf. They can also read your
mailbox items or send items on your behalf. For example, you can give another user
rights to accept and schedule your appointments.

Deleting a User from the Access List
When you want to remove a proxy from your Access List, highlight that proxy name in the
Access List dialog box, then choose Delete User.
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About GroupWise Remote Disks

The Client disks in the GroupWise Client/Admin Pack install GroupWise Remote to the
GroupWise system on your network. You can then install GroupWise Remote from
the network to your computer.

The Client disks cannot be used to install GroupWise Remote directly to a standalone
computer. If you have a stand-alone computer, such as a laptop at a remote location,
you must use the Remote Client disks to install GroupWise Remote. The Remote
Client disks are available in the GroupWise Remote for Windows Materials Pack,
which also includes a copy of this manual. To order the GroupWise Remote for
Windows Materials Pack or to receive additional information, please call the
GroupWise Sales Center at (800) 861-2507.

If you are outside of the United States, Puerto Rico, the U.S. Virgin Islands, or
Canada, please contact your local WordPerfect affiliate or authorized reseller.

Introduction

GroupWise Remote for Windows lets you perform many GroupWise functions while
you are away from your office. These functions include sending and receiving mail,
scheduling meetings, writing notes, and assigning tasks.

Using GroupWise Remote is divided into two sections: Remote Basics and More
About Remote. Remote Basics is designed to help you install, set up, and begin using
Remote. More About Remote contains additional information that you might find
helpful when using Remote. For instructions on commonly-used GroupWise features,
see Using GroupWise.

Getting Started Checklist

This checklist summarizes the steps for getting started with GroupWise Remote for
Windows. Tasks are in sequential order.

Task

Verify that your computer meets the
minimum system requirements for running
GroupWise remote.

Read How GroupWise Remote Works. This
section explains terminology and concepts
you should understand before setting up or
using GroupWise Remote.

Fill out the worksheet (if your system
administrator has not done so already).

Install GroupWise Remote.
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Task

Start and setup GroupWise Remote.

Create a modem connection.

Create a network connection (if applicable).

Test your connections.

Retrieve information (items, Address Book,
and so forth) from your master mailbox.

Send items (messages, appointments, and
so forth) to other GroupWise users.

GroupWise Remote Requirements

Hardware and
Software
Requirements

You must run Remote on a computer that meets the minimum hardware and software
requirements listed below.

Hardware/Software Minimum
Requirements

Recommended
Requirements

Computer 80386/20 80386/25 or better

DOS version 3.3 5.0 or higher

Windows version 3.1 3.1 or higher

OS/2 version (if
running under OS/2)

2.1 2.1 or higher

Extended memory 4M 8M or more

Disk space 13M required for
Remote files

17M

System
Requirements

Remote requires you to have a mailbox (your master mailbox) on your master
GroupWise system. You must also have a password assigned to your master
mailbox. Contact the system administrator at your master site (the site of your master
GroupWise system) if you do not have a master mailbox and password.

Terms You Should
Know

domain A collection of post offices; your post office belongs to a specific domain.

items Mail, appointments, tasks, notes, and phone messages.

master mailbox Your GroupWise mailbox in your master GroupWise system.

master site or master GroupWise system The GroupWise system where your master
mailbox is located.

master GroupWise system or master site The GroupWise system where your master
mailbox is located.
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All requests are listed in the Pending Requests to Master Mailbox dialog box, shown
below.

Sending Requests
When you connect to your master GroupWise system, any requests that have a
“Waiting to be Sent” status in the Requests list are sent to your master mailbox. After
a request is sent to your master mailbox, the master GroupWise system processes it.
For example, an item you sent is added to your Out Box and distributed to its
recipients, or a folder you created is added to your master mailbox.

Retrieving Responses
Many of the requests that you send generate responses. Assume you have sent a
request to retrieve items from your master mailbox. After processing your request,
your master GroupWise system creates a response that contains the items you
requested. Remote can then retrieve and process the response.

Modem Connection Compared to Network Connection

To access your master mailbox to send or retrieve information, you must connect to
your master GroupWise system through a modem connection or a network
connection.
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Modem Connection In most cases, you will use your modem to connect to your master GroupWise system
via a gateway, as shown below.

Post Office
with Your

Master
Mailbox

MASTER GROUPWISE SYSTEM

GroupWise
Gateway

Modem
Connection

Your Computer
with GroupWise

Remote

File
Server
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Network
Connection

Remote can also use a network connection to connect to your master GroupWise
system. For example, if your computer has a drive mapping to the post office
containing your master mailbox, Remote can use that network connection to send
requests and retrieve responses from your master mailbox.

Note: You can connect to any post office in your master GroupWise system to access
your master mailbox. You do not need to connect to the post office containing your
master mailbox.

Post Office
with Your

Master
Mailbox

MASTER GROUPWISE SYSTEM

Computer
with Your
Remote
mailbox

File
Server

File
Server

Post Office

A network connection is very useful for retrieving your master mailbox and Address
Book to your remote computer before you leave your master site because it transfers
information faster than a modem connection. In particular, it can save long-distance
phone costs associated with retrieving your master mailbox or large user lists via a
modem.

Setup Worksheet

The following worksheet will help you gather the information necessary to set up
GroupWise Remote. It is divided into six sections that correspond to specific types of
information you need to know. The system administrator of your master GroupWise
system can assist you in filling out the worksheet.

User Information

Full Name

User ID

Master Mailbox Password
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System Information

Domain

Post Office

Modem Information

Description (Name)

Com Port

Baud Rate (May depend on master
GroupWise system’s gateway modem.) If
you are having difficulty synchronizing,
try using a lower try using a lower baud
rate.

Time Zone Information

Remote User’s Time Zone

Time Zone observes Daylight Saving
Time?

Yes No

Modem Connection Information

Connection Name

Gateway Phone Number

Gateway Login ID

Gateway Password

Modem Script (name and location if
required)

Disconnect Method* • When All Updates Are
Received
• Do Not Wait for Responses
• Manually

Redial Attempts* Default = 5

Redial Retry Interval* Default = 1 minute

80 Setup Worksheet



Network Connection Information

Connection Name

Path to Post Office

Disconnect Method* • When All Updates Are
Received
• Do Not Wait for Responses
• Manually

* Disconnect Method, Redial Attempts, and Redial Retry Interval have default settings.
Unless your system administrator supplies you with different values for these settings,
use the default settings for now. You will be given the opportunity to change them
later.

Installing GroupWise Remote

You can install GroupWise Remote from floppy disks or from the network, depending
on which source you have access to. Steps for each method are provided below.

Installing From
Floppy Disks

The GroupWise Remote files are in compressed format on the Remote Client disks.
To decompress and install the files onto your computer’s hard drive,

1 Make sure that Windows is running.

2 Insert the Remote Client 1 disk in drive A of your computer.

3 Choose the File menu in the Windows Program Manager, then choose Run to open
the Run dialog box.

4 Type a:setup.exe in the Command Line box, then choose OK to open the Installation
Type dialog box.

5 Skip Installing From the Network below and proceed to Choosing Standard or Custom
Install.

Installing From the
Network

To install from the network, you need to know the path to the RMSETUP.EXE program.
This program is located in the OFWIN40 subdirectory of your post office directory. You
may need to ask your system administrator for assistance in locating the directory.

1 Make sure that Windows is running.
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2 Choose the File menu in the Windows Program Manager, then choose Run to open
the Run dialog box.

3 Type the complete path to the RMSETUP.EXE program in the Command Line box.
Include RMSETUP.EXE in the path. For example,
X:\POSTOFF\OFWIN40\RMSETUP.EXE, where POSTOFF is your post office
directory.

4 Choose OK to open the Installation Type dialog box.

5 Proceed to Choosing Standard or Custom Install below.

Choosing Standard
or Custom Install

You can choose Standard Install or Custom Install. Each option is described in the
Installation Type dialog box. The Network Install option does not apply to GroupWise
Remote and is disabled.

Standard Install

1 Choose Standard Install to start the installation.

The Standard Install dialog box appears, informing you of the program’s progress. When
all files have been installed, the Set Up Program Manager Group dialog box appears.

2 Choose OK to accept GroupWise as the name of the group you want Remote to
appear in.

or

Type another name in the Program Group box, then choose OK.

The GroupWise Installation Complete dialog box appears when GroupWise has been
successfully installed. Choose OK to close the dialog box, then continue with Setting Up
GroupWise Remote.

Custom Install
This option lets you select the GroupWise Remote files you want to install onto your hard
drive.
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1 Choose Custom Install to open the Custom Installation dialog box.

2 Choose Source to open the GroupWise 4.1a Installation dialog box.

3 Choose OK to accept the source drive and directory shown.

or

Type the source drive and directory you want, then choose OK.

4 Choose Destinations to open the Directory Selections dialog box.

5 Choose OK to accept the destination drives and directories as shown.

or

Type the destination drives and directories you want, then choose OK.

6 Choose Files to open the GroupWise Installation Options dialog box.
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All options in the GroupWise Installation Options dialog box are already selected.

7 Deselect the files you don’t want to install, then choose OK to return to the Custom
Installation dialog box.

8 Choose Start Installation.

The Custom Install dialog box appears informing you of the program’s progress. When all
files have been installed, the Set Up Program Manager Group dialog box appears.

9 Choose OK to accept GroupWise as the name of the group you want Remote to
appear in.

or

Type another name in the Program Group box, then choose OK.

The GroupWise Installation Complete dialog box appears when GroupWise has been
successfully installed. Choose OK to close the dialog box, then continue with Setting Up
GroupWise Remote below.

Setting Up GroupWise Remote

1 Double-click the GroupWise Remote icon to start GroupWise Remote.

The first time you start Remote, the GroupWise Remote 4.1a dialog box appears informing
you of the information you need to enter before you can use Remote. This is where you’ll
need to enter the information from your worksheet.

2 Click OK to open the Remote Preferences dialog box.

You can choose Help to learn

more about setting up and using

GroupWise Remote.

3 Type your full name and your GroupWise user ID as listed on your worksheet.

HINT: Do not press Enter after filling in a text box. Use the mouse or press Tab to move
between text boxes.
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4 Choose Password to open the Enter Password dialog box.

or

If you do not have a master mailbox password, choose Cancel twice, have your
system administrator create a master mailbox password for you, then start Remote
again.

5 Type your master mailbox password as listed on your worksheet, then choose OK.

6 Retype your password and choose OK to return to the Remote Preferences dialog box.

7 Type the domain and post office names listed on your worksheet.

8 Choose Modem to open the Modem Configuration dialog box.

9 Choose Modem to open the Modems dialog box.

10 Select the modem listed on your worksheet, then choose Select to return to the
Modem Configuration dialog box.

If your modem is not listed, you will need to create a modem definition. See Creating or
Editing a Modem Definition under More About Remote. Begin with step 5.

11 Choose Port to open the Port Settings dialog box.

12 Type the appropriate information from your worksheet in the Com Port and Baud Rate
boxes, then choose OK to return to the Modem Configuration dialog box.

13 Choose OK to return to the Remote Preferences dialog box.
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14 Choose Time Zone to open the Time Zone dialog box.

15 Choose Set Time Zone to open the Set Time Zone dialog box.

16 Select the time zone you want, then choose Select to return to the Time Zone dialog
box.

IMPORTANT: By default, Daylight Saving Time is active. If your area does not observe
Daylight Saving Time, or the time offset is not one hour, you need to edit the Daylight
Saving Time. See Editing Daylight Saving Time in Setting or Changing Your Time Zone
under More About Remote.

HINT: Remember to set your remote computer’s clock to match the time zone you
selected. See Changing Your Computer’s Clock in Setting or Changing Your Time Zone
under More About Remote.

17 Choose OK to return to the Remote Preferences dialog box.

18 Choose Reconcile to open the Reconcile dialog box.

Lets you delete Remote items

missing in your master

mailbox or update Remote

items changed in your master

mailbox

19 Specify your preferences, then choose OK to return to the Remote Preferences dialog
box.
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The final step in setting up Groupwise Remote is to define the connections to your master
Groupwise system.

20 Leave the Remote Preferences dialog box open, then proceed to the next section,
Creating a Modem Connection.

Creating a Modem Connection

You can create both a modem connection and a network connection, then switch between
the connections depending on your current needs. For example, you can create a network
connection to use while at your master site and a modem connection to use while away
from your master site. This section provides steps for creating a modem connection. The
next section, Creating a Network Connection, explains how to create a network
connection.

IMPORTANT: You can switch between a modem connection and a network connection
only if there are no pending requests on the connection you’re switching from.

1 If you are continuing from Setting Up Groupwise Remote, the Remote Preferences
dialog box should be open. If not, choose Preferences from the Main Window, then
choose Remote.

2 Choose Connections to open the Create Connection dialog box.

If you have not set up any connection, the Create Connection dialog box appears.

3 If you have previously created connections, choose Create from the Connections
dialog box to open the Create Connections dialog box.

4 Make sure that Modem is selected, then choose OK to open the Modem Connection
dialog box.

5 Type the connection name listed on your worksheet in the Connection Name box.

6 Type the gateway phone number listed on your worksheet in the Phone Number box.

IMPORTANT: You can use a comma to signal a one-second pause in the dialing [such as
9, (800) 555-1212]. The 9 accesses an outside line and the comma causes a one-second
pause to wait for the dial tone before dialing the number. Unrecognized symbols such as
dashes, spaces, and parentheses are ignored and can be included in the phone number
(such as (800) 555-1212).

7 Type the gateway login ID listed on your worksheet.
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8 Choose Password to open the Enter Password dialog box, then type the gateway
password listed on your worksheet.

9 Choose OK, retype the password, then choose OK again.

Remote supports scripting.

Contact your system

administrator if a script is

required, and see Additional

Information at the end of this

section.

Your modem appears here.

10 Select one of the methods in the Disconnect Method group box. The table below
explains each method.

Method Description

When All
Updates Are
Received

Disconnects after requests are sent and all responses to the
requests are received (or disconnects automatically when the time
allowed by the system administrator has expired).

Do Not Wait
for Responses

Disconnects immediately after requests are sent and waiting
responses are received. Waiting responses are responses that are
waiting for you at your master Groupwise system.

Manually Lets you manually control when to disconnect (or disconnects
automatically when the time allowed by the system administrator
has expired).

Your system administrator sets a time limit for Remote users to remain connected to the
master Groupwise system. If you select When All Updates Are Received or Manually as
your disconnect method, this time limit may cause you to be disconnected sooner than you
expected. If you are frequently disconnected in these modes, contact your system
administrator.

You can specify the number of times you want Groupwise Remote to automatically redial if
the line is busy. You can also specify the interval between each attempt.

11 Change the Redial defaults by typing new parameters in the Attempts and Retry
Interval boxes.

12 Choose OK to return to the Connections dialog box.

13 Select your connection, then choose Select to return to the Remote Preferences dialog
box.

14 Choose OK to return to the Main Window.

Your modem connection is now defined.

15 Proceed to the next section, Creating a Network Connection, if you want to create a
network connection.

or

Skip to Retrieving Information to begin using Groupwise Remote.
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Additional
Information

Creating Additional Modem Connections
You can create more than one modem connection. For example, if your master
Groupwise system’s gateway has multiple phone numbers that you can use to call in, you
can create a modem connection for each phone number. Then, when connecting to your
master Groupwise system, you would choose the modem connection you want to use.

To create additional modem connections, repeat the steps you completed to create your
first modem connection.

Editing a Modem Connection
After you have created a modem connection, you can change it through the Modem
Connection dialog box.

1 Choose the Remote menu in the Main Window, then choose Send/Retrieve to open
the Send/Retrieve dialog box.

2 Choose Connections to open the Connections dialog box.

3 Select the modem connection you want to edit, then choose Edit to open the Modem
Connection dialog box.

4 Make your changes, then choose OK to return to the Connections dialog box.

5 Choose Select, then choose Close to return to the Main Window.

Scripting
Remote supports scripting. You can use a script file when Remote exchanges information
with your master site before it can connect to your master Groupwise system. For
example, you can use a script to provide information that lets Remote gain access through
your site’s security system or into a modem pool.

1 Make sure you’re in the Modem Connection dialog box, then type a path and filename
for the script in the Modem Script box. The default path is to the Remote program
directory.

or

If you are selecting an existing script, click the folder next to the Modem Script box to
open the Select File dialog box, then double-click the script file.

If you are selecting an existing script, you are finished. If you are creating a script,
continue with the remaining steps.

2 Choose Edit Script to open the Edit Modem Script dialog box.

3 Type the appropriate script commands in the When given and Respond with boxes.
See Script Language under More About Remote for script commands and sample
scripts.

4 Choose Save, then choose Close to return to the Modem Connection dialog box.

Creating a Network Connection

In addition to your modem connection, you can set up a network connection. For a
network connection, you must have network access to a post office directory on the
network.

1 Choose the Remote menu in the Main Window, then choose Send/Retrieve to open
the Send/Retrieve dialog box.
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2 Choose Connections to open the Connections dialog box, then choose Create.

3 Select Network, then choose OK to open the Network Connection dialog box.

4 Type the connection name listed on your worksheet in the Connection Name box.

5 Type the complete path to any post office directory in your master Groupwise system in
the Path to Post Office box. (See your worksheet.)

6 Select the Disconnect Method you want.

Disconnects after requests are

sent and all responses to the

requests are received

Disconnects immediately after

requests are sent and waiting

responses are received

Lets you manually control when to

disconnect

7 Choose OK to close the Network Connection dialog box.

Notice that Network appears in the Type column on your Connection List.

If you plan to use the network connection first (such as to retrieve information from your
master mailbox while you are still at your master site), select Network as the connection
setup. If you plan to use your modem connection first, select a connection that shows
Modem in the Type column.

8 Choose Select, then choose Close to return to the Main Window.

Additional
Information

Editing a Network Connection

After you have created a network connection, you can change it through the Network
Connection dialog box.

1 Choose the Remote menu in the Main Window, then choose Send/Retrieve to open
the Send/Retrieve dialog box.

2 Choose Connections to open the Connections dialog box.
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3 Select the network connection you want to edit, then choose Edit to open the Network
Connection dialog box.

4 Make your changes, then choose OK to return to the Connections dialog box.

5 Select your network connection, choose Select, then choose Close until you return to
the Main Window.

Testing Your Connections

Before trying to retrieve information from your master mailbox or send items to other
Groupwise users, you should verify that no problems exist with the connections you
created. Instructions for testing a modem connection and a network connection are
provided below.

Testing Your
Modem Connection

To verify that your modem connection works, you should connect to your master
Groupwise system.

1 Choose the Remote menu in the Main Window, then choose Send/Retrieve to open
the Send/Retrieve dialog box.

2 Select your modem connection in the Current Connection drop-down list.

Because you are simply testing the modem connection to see if it works, you should not
retrieve any information at this point. Retrieving information from your master Groupwise
system is discussed in the next section, Retrieving Information.

3 Deselect Items so that no information will be retrieved.

4 Choose Connect to initiate the connection.

HINT: The modem on your remote computer will make a dialing sound which will change
to a screeching noise when it makes contact with your gateway’s modem. This procedure
could take several minutes depending on the number of times your modem dials before it
makes contact, and how many requests and responses your system has to transfer.

If the connection is working, the Connection Status dialog box displays a message stating
Connection Status: Connected.

5 If your disconnect method is set to Manually, double-click the Control-menu box to
disconnect and close the Connection Status dialog box.

If the test was successful, skip to the next section, Retrieving Information.

If the test wasn’t successful, the Groupwise Error dialog box may appear.
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6 Choose OK in the Groupwise Error dialog box, then choose Close in the Connection
Status dialog box.

7 Choose File, then choose Preferences.

8 Choose Remote to open the Remote Preferences dialog box.

9 Choose Modem to open the Modem Configuration dialog box.

10 Choose Port to open the Port Settings dialog box. Check your worksheet to make
sure that the settings are correct. You can select an option and choose Help for a
description of the option.

11 Close all dialog boxes, then repeat steps 1-5 above to retest the connection.

If the connection still does not work, contact your system administrator.

Testing Your
Network
Connection

To verify that your network connection works, you should connect to your master
Groupwise system.

1 Choose the Remote menu in the Main Window, then choose Send/Retrieve to open
the Send/Retrieve dialog box.

2 Select your network connection in the Current Connection drop-down list.

Because you are simply testing the network connection to see if it works, you should not
retrieve any information at this point. Retrieving information from your master Groupwise
system is discussed in the next section, Retrieving Information.

3 Deselect Items so that no information will be retrieved.

4 Choose Connect to initiate the connection.

If the connection is working, the Connection Status dialog box displays a message stating
Connection Status: Connected.

5 If your disconnect method is set to Manually, double-click the Control-menu box to
disconnect and close the Connection Status dialog box.

If the test was successful, skip to the next section, Retrieving Information.

If the test wasn’t successful, the Groupwise Error dialog box may appear.

6 Choose OK in the Groupwise Error dialog box, then choose Close in the Connection
Status dialog box.

7 Choose Remote, then choose Send/Retrieve.

8 Choose Connections to open the Connections dialog box.
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9 Select your network connection, then choose Edit to open the Network Connection
dialog box.

10 Check your worksheet to make sure the correct path appears in the Path to Post Office
box.

11 If the path is correct and your test is still unsuccessful, contact your system
administrator.

or

Type in the correct path as listed on your worksheet, then choose OK.

12 Choose Close to return to the Send/Retrieve dialog box, then choose Connect to re-
test the connection.

Retrieving Information (Downloading)

Once you have successfully tested your connection, you can retrieve information from your
master mailbox to your remote mailbox.

Retrieving Items 1 Choose the Remote menu, then choose Send/Retrieve to open the Send/Retrieve
dialog box.

Items button

Items check box

2 Make sure the Items check box is selected, then choose the Items button to open the
Select Items to Retrieve dialog box.

Deselect a check box if you

don’t want to update it.

Retrieving Information (Downloading) 93



3 Specify the Items to Update, Item Size Limits, and Time Period settings, explained
below.

Option Description

Items to Update Use the pop-up lists to specify the types of items
you want to retrieve. For example, you might
choose to retrieve mail and phone messages
that have not been opened and tasks that have
not been completed.

Get Subject Line Only If you generally retrieve a large number of items,
this option can help save time and reduce phone
costs by retrieving only the subject line of each
item. See Retrieving Selected Items in
Additional Information at the end of this section.

Get Contents Regardless of Size Retrieves all items in your master mailbox.

Get Contents If Smaller Than Retrieves all items that meet the size limits you
specify. Defaults are 30K for the Message Text
and Attachments, and 5K for the To, CC, and
BC boxes. See Retrieving Selected Items in
Additional Information at the end of this section.

Days Prior
Days After

Lets you specify a number of days prior to and
after today’s date to retrieve only the items that
fall between a range.

4 Choose OK to return to the Send/Retrieve dialog box, then continue with Retrieving
Your Address Book.

Retrieving Your
Address Book

Your Address Book can be helpful when you are unsure about user IDs, resource names,
or public group names, or when you need to address an item to several users. If you want
to use the Address Book in Remote, you need to retrieve it from your master Groupwise
system. If you do not want to retrieve your Address Book, skip to Connecting to Your
Master Groupwise System below.

HINT: Since this process can take quite some time, we recommend retrieving your
Address Book through a network connection while at your master site.

1 Make sure the Send/Retrieve dialog box is open.

2 Click the Address Book check box, then choose the Address Book button to open
the Address Book Filter dialog box.

3 Select the option you want and, if necessary, type the domain and post office names in
the appropriate text boxes.

4 Choose OK to return to the Send/Retrieve dialog box, then continue with Connecting to
Your Master Groupwise System below.

HINT: You can also retrieve folders, rules, public group members, and personal groups.
For information about each of these options, choose Help in the Send/Retrieve dialog box,
then choose the topic you want to learn about.
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Connecting to Your
Master Groupwise
System

Connecting to your master Groupwise system sends the number of items displayed in the
Send/Retrieve dialog box to your master Groupwise system. It also retrieves items from
your master mailbox to your remote mailbox, restricting them according to the limits you
set on your retrieve selections.

Initiating the Connection

1 Make sure the Send/Retrieve dialog box is open and that you have selected all the
information you want to retrieve.

2 Choose the connection you want from the Current Connection drop-down list, then
choose Connect to initiate the connection and to open the Connection Status dialog
box.

HINT: If you’re using a modem connection, the modem on your remote computer will make
a dialing sound which will change to a screeching noise when it makes contact with your
gateway’s modem. This procedure could take several minutes depending on the number
of times your modem dials before it makes contact, and how many requests and
responses your system has to transfer.

This will read “Connected”

when you have made a

successful connection.

Your Send/Retrieve has

completed when this reads 0

Requests Pending.

Minimizes Connection Status

dialog box without affecting

connection transmission

Displays maximum connection

information

Logging Your Connection Information
Remote can log information to the Connection Log dialog box and to a logfile
(REMOTE1.LOG, REMOTE2.LOG, or REMOTE3.LOG) on your hard drive. Choosing
Show Log displays maximum connection information. This includes modem initialization
commands, connection time, error messages, and so forth. Show Log is useful if you need
to troubleshoot a connection problem.

Disconnecting From Your Master Groupwise System
You can disconnect from your master Groupwise system anytime by choosing Close in the
Connection Status dialog box.

If you want to keep the Connection Status dialog box open, but terminate the connection,
choose Disconnect. This lets you observe the window information after you have
disconnected from your master Groupwise system. When you disconnect, notice that the
button changes to Connect. Choosing Connect re-establishes the connection to your
master Groupwise system.

Additional
Information

Retrieving Selected Items

After you have retrieved items from your master mailbox, you can release size limits you
may have set on those items with the Retrieve Selected Items option. Assume you chose
Get Subject Line Only in Item Size Limits, and, after reading the subject lines of your
items, you want to read the contents as well. Retrieve Selected Items lets you reconnect
with your master mailbox and retrieves the contents of the items you selected.

1 Double-click In Box, Out Box, or My Calendar in the Main Window, depending on
where the item is that you want to retrieve.

2 Select the items you want to retrieve.

3 Choose Remote, then choose Retrieve Selected Items.
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4 Choose Connect.

Remote connects with your master Groupwise system using the same connection as your
most recent connection. You can change the connection in the Retrieve Selected Items
dialog box, if you want.

5 If your Disconnect Method is set to Manually, choose Close in the Connection Status
dialog box after all items have been retrieved to your remote mailbox.

6 Read the items you want, then double-click the Control-menu box to return to the Main
Window.

Sending Items (Uploading)

Now that you have retrieved your items and Address Book, you are ready to send items to
other users. The following steps explain how to send a mail message. The procedure is
similar for sending appointments, tasks, notes, and phone messages.

From the Main Window,

1 Choose the Send Mail pop-up list, then choose a mail view.

2 Choose Address to open the Address Book.

3 Double-click user IDs to move them to the Send To box.

4 If you want a user to receive a carbon copy or blind copy, select the user, then choose
the CC or BC buttons.

5 Choose OK to close the Address Book and to move the names to the address boxes in
the mail view.

6 Type a description of the message in the Subject box.

7 Type the message in the Message box.

8 If you want to change the send options for the mail message, choose the Send menu,
then choose Send Options. Set the options you want, then choose OK.

9 Choose Send.

The mail message is placed in the Requests list. As soon as you connect to your master
Groupwise system, it will be sent.
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Connecting to Your
Master Groupwise
System

1 Choose the Remote menu, then choose Send/Retrieve to open the Send/Retrieve
dialog box.

2 Choose the connection you want from the Current Connection drop-down list, then
choose Connect to initiate the connection and to open the Connection Status dialog
box.

HINT: If you’re using a modem connection, the modem on your remote computer will make
a dialing sound which will change to a screeching noise when it makes contact with your
gateway’s modem. This procedure could take several minutes depending on the number
of times your modem dials before it makes contact, and how many requests and
responses your system has to transfer.

This will read Connected when

you have made a successful

connection.

Your Send/Retrieve has

completed when this reads

0 Requests Pending.

Minimizes Connection Status

dialog box without affecting

connection transmission

Displays maximum connection

information

Disconnecting from
Your Master
Groupwise System

You can disconnect from your master Groupwise system anytime by choosing Close in the
connection status dialog box.

If you want to keep the Connection Status dialog box open, but terminate the connection,
choose Disconnect. This lets you observe the window information after you have
disconnected from your master Groupwise system. When you disconnect, notice that the
button changes to Connect. Choosing Connect re-establishes the connection to your
master Groupwise system.
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Addressing

The Address and item sections in the reference manual explain how to address an item by
choosing user IDs from the Address Book or by typing the user IDs in the address boxes.
This section explains how to address an item to a user who is not on your post office.

GroupWise allows for multiple post offices and domains. Normally, your system
administrator will include each connected domain so all users are listed in the Address
Book. However, the system administrator can exclude users from the Address Book who
don’t want to be listed. You can still send items to those users if you type the full address.

Absolute
Addressing

Absolute addressing is like addressing a letter (for example, Lia Elstead, 121 Liberty
Street, Kanoa, Utah, 88434). Each GroupWise user and resource has an absolute
address consisting of the user’s or resource’s domain, post office, and ID. If you don’t
know the absolute address of a user, contact your system administrator. To use the
absolute address, you must type it in the address box using the syntax shown below.

domain.po.userID

When typing addresses for multiple users in different post offices, separate the addresses
with commas, as shown below.

domain.po1.userID, domain.po2.userID

If multiple users are on the same post office, you can place all the users in that post office
in parentheses and separate them with commas.

domain.po(user1ID, user2ID, user3ID)

Explicit Addressing Explicit addressing is used when you need to address an item through a gateway or
through one or more domains to reach the recipient’s domain. An explicit address
describes the pathway from your domain to the recipient’s domain in the same way you
would give someone directions to a hotel (for example, go to the park, turn right and go to
the cathedral, turn left and go three blocks, turn left and you will see the hotel).

Explicit addressing includes each gateway, domain, and post office the item passes
through before it reaches its destination. A path from one domain to another is designated
by a colon. A path from a domain to a post office, and a post office to a user, is
designated by a period, as illustrated below.

domain:domain:domain.po.userID

You can also reverse the order of the address and separate the domains, post office, and
user ID with the @ symbol.

userID@po@domain@domain

If you do not know the explicit address for a user, contact your system administrator.

If you need to address an item through a gateway (such as a gateway for sending a fax),
you will need to use explicit addressing. The syntax for addressing an item through a
gateway depends on the gateway you are using. Contact your system administrator for
the syntax you need to use for the gateway you are using.

Creating an
Address Alias

If you find that you are often typing the same address to send items, you can simplify
sending items by creating an alias for the address. An alias is a personal group you create
to simplify the name of a user whose address is across one or more gateways or domains,
or in a different post office.

For example, instead of typing the address, telephone number, and options each time you
send an item to a fax gateway, you can create a personal group for each number you fax
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to. When you want to address to the fax gateway and send to that number, you type the
name of the personal group that contains the fax gateway information.

1 Choose the Send menu, then choose Address Book.

2 Choose Create/Edit Group.

3 Choose External Address, type the address in the dialog box that appears, then
choose To.

4 Choose Save Group to open the Save Personal Group dialog box, type a name to
identify the external address in the Group Name box, then choose OK.

5 Choose OK to close the Address Book.

Changing Your Remote Preferences

You can change any of the user and system information, default settings, and connection
definitions that you set in Remote Preferences.

IMPORTANT: Changing the user ID, domain, or post office will cause you to lose all
information in your remote mailbox.

1 Choose the File menu in the Main Window, then choose Preferences.

2 Double-click Remote to display the Remote Preferences dialog box.

3 Make your changes, then choose OK.

If you changed the user ID, domain, or post office, a prompt box appears telling you which
information you changed and warning you that all information in your remote mailbox will
be lost. Choose Y to continue or choose N, then Cancel if you do not want the changes
saved.

4 Choose Close in the Preferences dialog box to return to the Main Window.

Creating or Editing a Modem Definition

When you create or edit a modem definition, you describe the details of your remote
computer’s modem so Remote knows the proper specifications to use to connect to your
master GroupWise system.

Refer to your modem manual as you create or edit your modem definition.

Specifying Modem
Settings

1 Choose the File menu in the Main Window, then choose Preferences to open the
Preferences dialog box.

2 Double-click Remote to open the Remote Preferences dialog box.

3 Choose Modem to open the Modem Configuration dialog box.

4 Choose Modem to open the Modems dialog box.
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5 Choose Create to open the Modem Definition dialog box, then type the modem name
in the Description box.

or

Select the modem you want to modify, then choose Edit.

6 Type the applicable information from the table below in the Commands group box.

Text Box Definition

Initialization The commands used by Remote to initialize the
modem. The Initialization box can contain a
maximum of 255 characters. If you need multiple
lines in the command string, use the single prime
( ) to embed control characters such as a hard
return. See Modem Initialization Commands in
Additional Information at the end of this section for
details.

Hang Up The commands needed for the modem to hang up
and reset itself.

Dialing The commands to dial the modem. Include any
commands for tone or pulse dialing, dial pauses,
and so forth.

Suffix This field is usually not required. It is used only for
special cases such as cellular phones.

Answer This option does not apply. Remote cannot answer
incoming calls.

No Answer The command to disable answering of calls.

If your modem provides error correction, you need to choose the error correction type and
define the correction string. If not, skip to step 10 below.
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7 Choose the Type pop-up list, then choose the protocol type you want.

Five common error correction

protocols are listed, as well as

an Other option for the

protocol of your choice.

8 Type the error correction commands in the String box. Contact your system
administrator for the appropriate commands.

9 Select the Auto Baud Detect check box if you defined your computer’s modem and
your gateway’s modem at different baud rates.

Auto Baud Detect will synchronize the modems at the slower of the two rates to allow the
modems to communicate with each other.

10 Type a number between 0 and 18 in the Pacing box.

The character pacing is the time interval between each character GroupWise sends to the
modem when the modem is in command mode. The number you enter represents 1/18 of
a second. For example, typing 18 will cause a one-second pause between characters.
Type 0 if your modem does not require a pause between each character.

11 Type the escape character that instructs the modem to switch from terminal mode to
command mode in the Escape Character box.

12 Type the maximum baud rate that the modem can use to receive information from
Remote in the Baud Rate box.

13 Select Delayed Time Outs if you have a wireless modem and require additional delay
time to prevent disconnections.

14 Choose OK to save the definition and close the Modem Definition dialog box.

15 Make sure the modem you created is selected in the Modem List, then choose Select
to return to the Modem Configuration dialog box.

The modem name appears in the Modem field.

Specifying Port
Settings

The Port Settings dialog box displays the com port and baud rate for the modem you just
specified. If either of these are incorrect, you need to edit the port settings.
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1 Choose Port in the Modem Configuration dialog box to open the Port Settings dialog
box.

2 Choose the appropriate value in the corresponding drop-down list for each setting.
The settings are described below.

Setting Definition

Com Port The serial communication port number used by the modem.

Baud Rate The baud rate the modem should use when sending and receiving
information from the gateway.

Parity Parity Bit is None. This probably will not need to change. Contact
your system administrator.

Data Bits Character Length is 8. This probably will not need to change.
Contact your system administrator.

Stop Bits Stop Bits is 1. This probably will not need to change. Contact your
system administrator.

Flow Control Flow Control is CTS/RTS. This probably will not need to change.
Contact your system administrator.

3 Choose OK to save the values and close the Port Settings dialog box.

4 Choose OK to close the Modem Configuration dialog box.

5 Choose OK to close the Remote Preferences dialog box.

6 Choose Close to return to the Main Window.

7 Test your connection to verify that it works. See Testing Your Connections under
Remote Basics.

Additional
Information

Modem Initialization Commands
The commands used by Remote to initialize the modem include the following:

• Enable verbal result codes
• Turn command echo off
• Track data carrier
• Return CONNECT messages
• Drop carrier and reset modem when DTR drops
• Link DTE speed to appropriate speed indicated by DCE CONNECT message. See

table below.

CONNECT Message DTE Speed

CONNECT 300
CONNECT 1200 1200
CONNECT 2400 2400
CONNECT 4800 4800
CONNECT 7200 9600
CONNECT 9600 9600
CONNECT 12000 19200
CONNECT 14400 19200
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CONNECT Message DTE Speed

CONNECT 19200 19200
CONNECT FAST 19200

Script Language

Scripts contain 16 pairs of When given and Respond with fields. When given fields can
be a maximum of 17 bytes (characters). Respond with fields can be a maximum of 49
bytes. If a Respond with string exceeds the 49-byte limit, you can leave the next When
given field empty and continue in the next Respond with field.

Script Commands All of the commands described below can be in uppercase or lowercase.

Command Description

^character Outputs the specified control character. Common control
characters are ^m (carriage return), ^j (line feed), ^i (tab), and ^[
(escape). See your DOS manual for additional control
characters.

 Waits 0.5 seconds.

@A[#]"text" Asks for the question in the quotes, prompts for a response, and
then sends the response to the modem. The number (0 or 1) in
the square brackets is optional. 0 echoes the response while 1
specifies no echo.

@B[#] Sends a break signal # milliseconds long. For example, 1000
causes a 1-second break.

@D[#] Controls screen display for modem output. Display off is 0,
display on is 1.

@O[#] Controls modem and screen display for script output. Modem
display only is 1, screen display only is 2, and both is 3.

@P"br,pb,db,sb" Modifies port parameters. The first parameter is baud rate (valid
numbers), then parity bit (N, E, O), then data bits (7, 8), and then
stop bits (1, 2). Any field can be omitted and commas
concatenated (for example, @P"2400,n,,1"). If a field is omitted,
the current setting is used.

@T Uses Dumb Terminal mode. Dumb Terminal mode echoes
everything, regardless of the @D or @O settings. F7 exits you
from the mode.

@W[#] Waits for # milliseconds before continuing with next command.
0 instructs Remote to wait until the output buffer is empty. A
number instructs Remote to wait the specified time. For
example, 1000 instructs Remote to wait 1 second.

Sample Scripts The following is a sample script for exchanging information with a Blackbox security
system that is set up for callback. Notice that the first When given field is left empty. This
will usually be the case because you are initiating the conversation.

When given Respond with

^MATDT888^M
PRIMARY  wendy^M
ACCEPT @D[1]
NO CARRIER  ATSO=2^M
SECOND  peters^M
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When given Respond with

ACCEPT ^M

The following script is similar to the above script, except the Blackbox security system is
set up for passthrough.

When given Respond with

^MATDT888^M
PRIMARY  ed^M
SECOND  jones^M
ACCEPT  ^M

Setting or Changing Your Time Zone

All items in your Calendar are scheduled according to the time zone you chose when you
initially set your Remote Preferences. As you cross time zones with GroupWise Remote,
you can change to the new time zone. If you do, all scheduled items will change to reflect
the difference between the time zones.

For example, assume you chose Eastern Standard in your initial Remote Preferences, and
you are currently working in the Pacific Standard time zone. If you change your time zone
in Remote to Pacific Standard, a 3 p.m. appointment will display as a 12 noon appointment
in Remote.

IMPORTANT: If you change Remote’s time zone, be sure to change your remote
computer’s clock to match the new time zone. See Changing Your Computer’s Clock later
in this section.

1 Choose the File menu in the Main Window, then choose Preferences.

2 Double-click Remote to open the Remote Preferences dialog box.

3 Choose Time Zone to open the Time Zone dialog box.

4 Choose Set Time Zone to open the Set Time Zone dialog box.

5 Select the new time zone, choose Select, then choose OK to close the Time Zone
dialog box.

6 Choose OK in the Remote Preferences dialog box, then choose Close in the
Preferences dialog box to return to the Main Window.

Editing Daylight
Saving Time

Use Edit Daylight Saving Time to specify when daylight time and standard time begin.

1 Choose the File menu, then choose Preferences.

2 Double-click Remote to open the Remote Preferences dialog box.

3 Choose Time Zone, then choose Edit Daylight Saving Time.

4 If your time zone is not observing daylight time, deselect the Use Daylight Saving
Time check box.

5 Select Define by Day or Define by Date.

6 Specify when daylight saving time begins and when standard time begins using the
pop-up lists.

7 Specify the number of hours and minutes your clock should change, then choose OK.
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8 Choose OK to close the Time Zone dialog box.

9 Choose OK in the Remote Preferences dialog box, then choose Close in the
Preferences dialog box to return to the Main Window.

Changing Your
Computer’s Clock

Always change the clock in your remote computer when you change Remote’s time zone.
This will ensure synchronization of all scheduled items between your new time zone and
your computer’s clock.

1 Double-click Control Panel in the Main window of the Windows Program Manager,
then double-click Date/Time.

2 Make your changes, then choose OK.

HINT: You may prefer not to change time zones when you travel. If you are in New York
and schedule an appointment in Los Angeles for 3 p.m., then fly to California and choose
not to change time zones in Remote, the appointment will still display at 3 p.m., and your
schedule will not be altered.

Generally, if you’re planning to work in another time zone at length, you may find it
preferable to change your time zone in Remote.
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Modem

initialization commands 103
script, creating 89
settings 100

Modem connection
creating 87
definition 76
editing 89
initiating 95
logging information 95
overview 78
testing 91

Modem definitions
creating 100
editing 100

Modify Preferences/Rules rights
70

Mouse actions 18
Multiple items, selecting 29

N

Network, installing Remote from
the 81

Network connection
creating 89
definition 76
editing 90
overview 79
testing 92

No Answer (modem parameter)
101

Noise, modem 91, 95, 97
Notes

accepting 25, 40
attachments 22, 47
declining 25, 40
delegating 28
deleting 28, 33
description 17
forwarding 27
italicized descriptions 25
personal, creating 61
printing 24, 43
priority 62
reading 22
recurring, scheduling 53
replying 27
rescheduling 32, 41
resending 32
retracting 32
sending 61
temporary send options 62

Notices see Notes
Notify Recipients option

appointment 54
mail 49
notes 62
phone messages 66
tasks 59

Novell GroupWise see
GroupWise, GroupWise
Remote

O

OLE attachments 24
One-second pause in gateway

phone number, including 87
Opening items see Reading items
Options

temporary appointment 54
temporary mail 49
temporary note 62
temporary phone message 66
temporary task 59

Organizing items into folders 29
OS/2 version required for

GroupWise Remote 75
Out Box

deleting items 33
description 16

folders 29
icons 17
printing 24
rescheduling items 32
resending items 32
retracting 33
tracking item information 34
verifying status of sent items 34

Overdue tasks 40, 42
Overview

GroupWise 16
GroupWise Remote 75

P

Paper clip, icon 23
Paper clip icon 17
Parity 103
Password 16
Pathnames, including in

addresses 99
Pause in gateway phone number,

including 87
Personal

address group aliases 99
appointments, scheduling 52
groups, creating 48
groups, deleting names from 48
notes, creating 61
tasks, creating 58
views, description 17

Phone costs, saving on
long-distance 79

Phone Message feature,
description 17

Phone Messages
attachments 22, 47
deleting 28, 33
description 17
forwarding 27
printing 24
priority 66
reading 22
replying 26
resending 32
retracting 32
sending 65
temporary send options 66

Phone number, gateway 87
Place, resources 51
Post office

addressing items to Remote 99
definition 76

Printing
attachments 24
Calendar items 43
items 24

Priority, task 57
Priority option

appointments 54
mail 49
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notes 62
phone messages 66
tasks 59

Program, running the setup 15
Proxy 71

acting as 69
archiving rights 70
definition 71
deleting from Access List 71
for another user 69
letting someone manage your

mailbox 69
returning to your own mailbox

69
rights 70

Proxy List, accessing 69
Public groups 48

Q

QuickMenu
accepting items 41
declining items 41

QuickTour description 19

R

Read Message Marked Private
rights 70

Read rights 70
Reading

attachments 22
items 22

Recipients' actions, tracking 34
Recommended requirements 75
Recovering deleted items 37
Recurring items, scheduling 53
Reference manual 18
Remote

concepts 75
installing 81
installing from floppy disks 81
installing from the network 81
mailbox, definition 76
setting up 84
system requirements 75

REMOTE1.LOG 95
REMOTE2.LOG 95
REMOTE3.LOG 95
Removing proxies from your

Access List 71
Reply Requested option

mail 49
phone messages 66

Reply to All option 27
Replying

to items 26
without accepting or declining

27
Requests

actions that create 76
definition 76

sending 77
Requirements, GroupWise

Remote 75
Rescheduling

Calendar items 41
Out Box items 32

Resending items 32
Reset, Auto-Dates 54
Resources 51

scheduling 48
Responses

definition 77
when generated 77

Retracting
items 32
items while rescheduling 33
items while resending 33

Retrieve options, setting 93
Retrieving

Address Book in Remote 94
Remote information 93
selected Remote items 95

Return Notification option
appointment 54
mail 49
notes 62
phone messages 66
tasks 59

Right-clicking 18
Rights, granting to proxies 69
Root folder 29
Routing slips, completing 42
Running

other applications 24
setup program 15

S

Schedule feature, description 17
Scheduling

appointments 51
Auto-Dates 53
Busy Search, using 52
meetings 51
notes 61
personal appointments 52
recurring items 53
resources 48
tasks 57

Script, creating modem 89
Searching for names in Address

Book 46
Selecting multiple items 29
Send Mail feature, description 17
Send options

temporary appointment 54
temporary mail 49
temporary note 62
temporary phone message 66
temporary task 59

Sending

appointments 51
items to personal groups 52
mail 46
notes 61
phone messages 65
Remote items 96
requests 77
tasks 57

Setting
computer’s clock 106
time zone 105

Setting up GroupWise Remote 84
Setup program, running 15
SETUP.EXE 15
Shelf, description 17
Shift-clicking 18
Show Log option 95
Software/harware requirements,

GroupWise Remote 75
Sound

attachments, listening 23
modem 91, 95, 97

Speaker icon 17
Standard install 82
Starting

GroupWise 15
GroupWise Remote 81
Setup Program 15

Status, completed items 43
Status Information, checking from

Out Box 34, 35
Status Information option

appointments 54
mail 49
notes 62
phone messages 66
tasks 59

Stop bits 103
Subfolders 29
Subscribe to My Alarms rights 70
Subscribe to my Notification rights

70
Suffix (modem parameter) 101
Support, Customer 18
Syntax for addressing 99
System

administrator 19
requirements, GroupWise

Remote 75

T

Tasks
accepting 25, 40
assigning 57
attachments 22, 47
Busy Search, using 52
completed status 43
completing 42, 43
declining 25, 40
delegating 28
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deleting 28, 33
description 17
forwarding 27
italicized descriptions 25
overdue 40, 42
personal, creating 58
printing 24, 43
priority 57
reading 22
recurring, scheduling 53
replying 27
rescheduling 32, 41
resending 32
retracting 32
temporary send options 59
uncompleted 40, 42
undeleting 37

Telephone number, gateway 87
Temporary Send Options

appointments 54
mail 49
notes 62
phone messages 66
task 59

Terms, common GroupWise
Remote 75

Testing
modem connection 91
network connections 92

Text
bolded in manual 18
icons in documentation 18

Time, changing your computer's
clock 106

Time zone, setting/changing 105
Tracking item information 34
Trash

automatic cleanup 38
description 16
emptying 37
undeleting items in 37

Typing user IDs, rules for 46

U

Undeleting Trash items 37
User IDs, rules for typing 46
Users, addressing items to

Remote 99
Using

GroupWise Basics 18
GroupWise Remote 18

V

Verifying status of Out Box items
34

Version requirements, workstation
software 75

View attachments 47

Views
calendar 17
group 17
personal 17

W

When All Updates Are Received
option 88

Windows version required for
GroupWise Remote 75

WordPerfect file, attaching to
items 47

Words, bolded in manual 18
Worksheet 79
Workstation software

requirements 75
Write Note feature, description 17
Write rights 70
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